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NOTICE
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SECTION 1 INTRODUCTION

USING THIS 
MANUAL

The sections in this manual provide the following 
information on the 375 Field Communicator. 

Section 2: Learning the Basics contains 
information on settings, types of storage, IrDA® 
communication, using ScratchPad, maintenance, 
managing files and storage.

Section 3: HART Functionality contains 
information on starting the HART® application, 
establishing communication with connected HART 
devices, and configuring the HART application.

Section 4: Fieldbus Functionality contains 
information on starting the fieldbus application, 
establishing communication with connected 
fieldbus devices, viewing the Live Device List, 
block lists, and configuring the fieldbus application.

Section 5: Troubleshooting provides solutions to 
the most common 375 Field Communicator 
operating problems.

Appendix A: Reference Information provides 
physical, functional, and performance 
specifications.

Appendix B: Approval Information contains 
Hazardous Location Certifications, European 
directive information, and approval drawings.
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SECTION 2 LEARNING THE BASICS

OVERVIEW This section provides instructions on basic features 
and functions of the 375 Field Communicator. It 
also provides information on starting, shutting 
down, configuring, using the ScratchPad 
application, and maintaining the 375 Field 
Communicator. The functionality described in this 
section is based on system software version 1.8.

SAFETY 
MESSAGES

Procedures and instructions in this section may 
require special precautions to ensure the safety of 
the personnel performing the operation. 
Information that raises potential safety issues is 
indicated by a warning symbol ( ). Refer to the 
following safety messages before performing an 
operation preceded by this symbol. Other warning 
messages can be found in the Troubleshooting 
section of this manual. 

IMPORTANT NOTICE

Ensure the battery pack and the 375 Field Communicator are properly aligned during assembly 
to prevent damage to the connector pins.

IMPORTANT NOTICE

During assembly/disassembly:
Do not pull up on the battery pack as this could damage the power supply connector. The 
System Card must only be inserted or removed by applying gentle pressure in line with axis of 
the card and socket. Do not pull upwards or press downwards on the card as this may cause 
damage to the card or the unit and void warranty.
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INSTALLING 
THE SYSTEM 
CARD AND 
THE BATTERY 
PACK

1. Place the 375 Field Communicator face down on 
a level, secure surface; see Figure 2-1.

2. Lock the stand into the hanger position. To pivot 
past the stand position, squeeze the stand 
together near the hinge.

Figure 2-1.  Back side of the 375 Field Communicator

WARNING

Contact with the touch screen should be made by blunt items only, preferably the stylus included 
with the 375 Field Communicator. The use of sharp instruments, such as screwdrivers, can 
cause failure of the touch screen interface. 

WARNING

Initiating a Re-Flash initiates reinstallation of the firmware and software from the System Card. 
This should only be performed under the direction of technical support personnel.

Battery pack 
retaining screws

Battery pack

System Card

Stand Assembly

Battery pack charge 
indicator button

Main unit 
label
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3. With the battery pack removed, place the 
System Card, with the card contacts facing up, 
on the main unit System Card guide ribs (located 
directly below the battery pack connector). Insert 
the System Card until it is firmly in place.

4. With the main unit still face down, ensure the 
tops of the two battery pack retaining screws are 
flush with the top of the battery pack.

5. Install the battery pack by aligning the sides of 
the battery pack and main unit and carefully 
sliding the battery pack forward until it is secure. 
If the battery pack and main unit are not properly 
aligned, the connector pins can be damaged.

6. Tighten the two battery pack retaining screws 
until they are secure (do not overtighten). The 
tops of the screws should now be close to flush 
with the stand groove.

STARTING UP 
AND 
SHUTTING 
DOWN

Prior to using the 375 Field Communicator without 
the charger/power supply, fully charge the battery 
pack. A full charge is indicated by a solid green 
light on the charger/power supply. Charging may 
take up to two hours. The 375 Field Communicator 
may be used while charging. Before operating the 
375 Field Communicator, ensure:
• The 375 Field Communicator is not damaged.
• The battery pack is fully seated.
• All screws are sufficiently tightened.
• An Expansion Module (EM) or Expansion Port 

Plug is in place.
• The communication terminal recess is free of dirt 

and debris.
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Starting the 
375 Field 
Communicator

Press and hold the on/off key until the Multifunction 
LED flashes to indicate the unit is powering 
(approximately two seconds). See Figure 2-2 for 
on/off key location.

During start-up, the 375 Field Communicator will 
automatically install any software upgrades 
available on the System Card. Once complete, the 
375 Main Menu will be displayed. After starting the 
375 Field Communicator, you can choose to:
• Launch the HART or FOUNDATION fieldbus 

Applications (if licensed)
• Configure/view Settings
• Enter Listen for PC 
• Launch the ScratchPad application

Shutting down While applications are open, the on/off key is 
disabled. You must exit to the 375 Main Menu 
before using the on/off key. To shut down the 375 
Field Communicator press and hold the on/off key 
until the display turns off (approximately three 
seconds). 

You can also power the 375 Field Communicator 
off by simultaneously pressing the backlight 
adjustment key and the function key until the 
display turns off. This is a mechanism by which the 
power down is accomplished in the hardware 
(similar to removing the power to a PC using a 
switch). This is not the recommended way of 
shutting off the 375 Field Communicator. 
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BASIC 
FEATURES 
AND 
FUNCTIONS

Figure 2-2.  375 Field Communicator diagram

Backlight 
adjustment key

IrDA interface
(top)

Touch screen
display

HART and fieldbus 
communication 
terminals (top)

Expansion port
(side)

Enter key

Function key 
(for multiple-key 
combination functionality)

Alphanumeric keypad

Power supply/charger 
connection (side)

Multifunction LED

On/off key

Navigation keys
(four arrow keys)

Tab key

Stylus 
(back)
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Using the 
keypad

The 375 Field Communicator keypad and touch 
screen have nearly total functional redundancy. 

On/off key
The on/off ( ) key is used to power on and off the 
375 Field Communicator. 

Arrow navigation keys
Four arrow navigation keys allow you to move 
through the menu structure of the applications. 
Press the right arrow navigation key ( ) to 
navigate further into the menu.

Enter key
The enter ( ) key allows you to launch the 
focused item or to complete an editing action. It 
does not navigate you through a menu structure. 
For example, if you have the Cancel button in 
focus (highlighted) when you push the enter key, 
you will be choosing to cancel out of that particular 
window. 

Tab key
The tab ( ) key allows you to move between 
selectable controls.
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Alphanumeric keypad
The alphanumeric keypad allows you select to 
both letters, digits, and other characters, such as 
punctuation marks. It can perform a selection of 
options and data entry in either numeric or 
alphanumeric modes. The 375 Field 
Communicator will automatically determine the 
mode depending upon the input necessary for the 
particular field. 

When in alphanumeric mode, to enter text press 
the desired keypad button in quick repetition to 
scroll through the options to achieve the 
appropriate letter or number. For example, to type 
the letter Z, press the 9 key quickly four times; see 
Figure 2-3.

Figure 2-3.  Keypad button functionality example 

Backlight adjustment key
The backlight adjustment ( ) key allows you to 
adjust the intensity of the display. There are four 
different settings. Intensity impacts the battery life 
of the 375 Field Communicator. Expect a shorter 
battery life for higher intensities; see “Backlight” on 
page 2-11 for settings.
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Function key
The function ( ) key allows you to enable 
alternate functionality on select keys. The grey 
characters on the keys indicate the alternate 
functionality. When enabled, the orange 
multifunction LED light will appear and an 
indication button can be found on the Soft Input 
Panel (SIP). If the function key is enabled, press 
the key again to disable the functionality.

The alternate function on the Tab and 
alphanumeric 5 key (insert) will be activated in 
future releases of the 375 Field Communicator 
software.

Multifunction LED 
The multifunction LED allows you to recognize 
when the 375 Field Communicator is in various 
states; see Table 2-1.

Table 2-1.  Multifunction LED

Using the 
touch screen

The touch screen display allows you to select and 
enter text by touching the window. Tap the window 
once to select a menu item or to activate a control. 
Double-tap to move further into the menu level.

NOTE
All instructions in this manual are written for the 
touch screen.

Multifunction LED Processing indication 

Solid green The 375 Field Communicator is on.

Flashing green The 375 Field Communicator is in 
power saving mode. The display is off.

Solid green and orange The Function key is enabled.

Blink green and orange The on/off button has been held down 
long enough for power up.
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The touch screen should be contacted by blunt 
items only, preferably the stylus included with the 
375 Field Communicator. The use of sharp 
instruments, such as screwdrivers, can cause 
failure of the touch screen interface. Repair of the 
touch screen requires replacement of the entire 
375 Field Communicator display assembly, which 
is possible only at an authorized service center. 

Use the back arrow button ( ) to return to the 
previous menu. Use the terminate button ( ) in 
the upper right corner of the touch screen to end 
the application.

Using the Soft Input Panel (SIP) keyboard
The SIP keyboard allows for alphanumeric input 
using the touch screen. The SIP keyboard detects 
when you need to enter characters and will appear 
automatically as required. 

VIEWING THE 
375 MAIN 
MENU

The 375 Main Menu allows you to run the HART 
application, run the Settings menu, communicate 
with a PC, and launch the ScratchPad application.

Figure 2-4.  375 Main Menu example

375_Man_RevD.book  Page 9  Wednesday, December 1, 2004  11:40 AM



Learning the Basics2-10

Starting the 
HART 
application

From the 375 Main Menu double-tap HART 
Application to run the HART application. On 
startup, the HART Application will automatically 
poll for devices.

Starting the 
fieldbus 
application

From the 375 Main Menu double-tap Foundation 
Fieldbus Application to run the fieldbus 
application. 

Running the 
Settings menu

From the 375 Main Menu double-tap Settings to 
view the Settings menu.The Settings menu allows 
you to set preferences for the 375 Field 
Communicator. The Settings menu also allows you 
to view system properties and license information. 
To access the 375 Field Communicator settings:
1. From the 375 Main Menu select Settings.
2. Select the desired setting from the Settings 

menu.

About 375
About 375 allows you to view the software property 
revisions of your particular 375 Field 
Communicator. If you need to call technical 
support personnel, have the System Software 
version, Communication and Diagnostic Circuitry 
(CDC) version, and the Operating System version 
on hand. 

Launching the RE-FLASH initiates the 
reinstallation of the firmware and software from the 
System Card. This should only be performed under 
the direction of technical support personnel. 
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Backlight
The backlight setting allows you to adjust the 
intensity of the display. To adjust the backlight, 
drag the slider left to right. When you find an 
appropriate backlight setting select OK for this 
session only, SET DEFAULT to retain this setting 
upon start up, or CANCEL to exit without changes.

Clock
The clock setting allows you to set the date and 
time on the 375 Field Communicator. Configure the 
date by using the drop down menu. To configure 
the time, highlight the appropriate time field and 
use the arrows to scroll through values until you 
find the correct time. Select OK to close. 

Contrast
The contrast setting allows you to adjust the 
lightest and darkest areas on a display screen.

To adjust the contrast, drag the slider left or right. 
The window will automatically adjust the contrast 
as you move the slider. When you find an 
appropriate contrast setting select OK for this use 
only, SET DEFAULT to retain this setting upon 
start up, or CANCEL to exit without changes.

NOTE
Temperature can affect contrast.
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Event capture
The event capture setting allows you to turn on 
and off the event captures and also allows you to 
delete event capture (.rec) files. An event capture 
is a log of communication, input, and screen output 
that occurs between the 375 Field Communicator 
and a device (HART only). 
1. Activate event capture in the settings menu by 

tapping the desired radio button. The radio 
button will be highlighted white when selected. 
To delete an event capture tap the DELETE 
EVENT FILE button. 

With event capture enabled, starting the HART 
application will activate an event capture dialog 
box for you to enter a file name. Enter the name 
and tap OK. The file will be saved to a default 
location.

NOTE
While event capture is enabled, device warning 
messages will not appear. 

Event captures are helpful in troubleshooting. 
1. Create an event capture.
2. Transfer the event capture to a PC with the 

Programming Utility; see Programming Utility 
online Help for more information.

3. E-mail the event capture to technical support 
personnel who will then be able to view the 
specific communication.
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License
Licensing can be viewed when you turn on the 375 
Field Communicator and in the license settings 
menu. The license setting allows you to view the 
license on the System Card. The HART application 
license is standard in every 375 Field 
Communicator. Other licenses available include 
the FOUNDATION fieldbus application and Easy 
Upgrade option. Unlicensed features cannot be 
accessed. 

Memory
The memory setting allows you to view available 
free space in the System Card, Internal Flash, 
RAM, and Expansion Module (if installed). 

Power
The power setting allows you to specify power 
management and to view battery/charge status.To 
specify the power management settings select the 
time interval from the drop down menus.

The power saving mode will turn off the backlight, 
the display and reduce power consumption to a 
minimum. The green multifunction LED light will 
flash while in power saving mode. To exit out of the 
power saving mode press any key or tap the touch 
screen. The 375 Field Communicator will return to 
the previously running mode.

The auto-off will turn off the 375 Field 
Communicator after the specified duration of 
inactivity. 

NOTE
The auto-off functionality will be disabled 
automatically during certain operations to prevent 
the unintentional loss of data.
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When you determine an appropriate power 
management setting select OK for this session 
only, Set Default to retain this setting upon start 
up, or Cancel to exit without changes. 

Power supply is indicated at the bottom of the 
screen. When on battery power, a percent charge 
remaining bar will be present. A message will 
appear when on external power.

Touch screen alignment
The touch screen alignment setting allows you to 
calibrate the touch screen with the display. Tap the 
cross hairs firmly and accurately at each location 
on the window. The target will continue to move 
until the touch screen is aligned. Touch screen 
alignment will be retained upon start up.

Exit to the 375 Main Menu
Double-tap Exit to 375 Main Menu if you want to 
return to the 375 Main Menu.

Communicating 
with a PC

IrDA communication with PCs
The 375 Field Communicator communicates with 
PCs using infrared technology. IrDA is the only PC 
interface supported for the transfer of device 
descriptions, software updates, configurations, 
event captures, and ScratchPad files.

IrDA communication can either be built into the 
PC, such as a laptop, or provided through an 
adapter such as a USB to IrDA adapter. Refer to 
your IrDA manual for installation and operating 
instructions.

Throughput for infrared communications with the 
375 Field Communicator is approximately 
4 kilobytes/second. Maximum recommended 
distance between the IrDA and PC is 18 inches.

375_Man_RevD.book  Page 14  Wednesday, December 1, 2004  11:40 AM



Learning the Basics 2-15

Listen For PC 
In Listen for PC, the 375 Field Communicator is 
under the control of a PC application for 
transferring data and managing device 
configurations. The PC application could be one of 
the following:
• AMS™ Suite: Intelligent Device Manager 

(version 6.2 or higher), software for managing 
instrumentation and valves in a process plant. 
Currently, AMS only supports HART 
configurations. In the future, it will also support 
FOUNDATION fieldbus configurations.

• 375 Field Communicator Easy Upgrade 
Programming Utility

To enter Listen for PC:
1. From the 375 Main Menu, select Listen for PC.
2. Align the 375 Field Communicator IrDA interface 

with the PC IrDA interface. 
3. Complete the necessary transfer(s) using the 

Programming Utility or AMS Suite: Intelligent 
Device Manager; see the Programming Utility 
online Help for more information.

4. Tap EXIT to close the Listen for PC application.

If new system software was downloaded to the 375 
Field Communicator System Card, an update of 
the Internal Flash will occur upon exit. 
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Transferring HART configurations using AMS 
Suite: Intelligent Device Manager 
A Handheld Communicator Interface kit of the 
Intelligent Device Manager (version 6.2 or higher) 
option lets you use the 375 Field Communicator 
with AMS. 
1. Align the 375 Field Communicator IrDA interface 

with the PC IrDA interface and then enter Listen 
for PC. A 375 Field Communicator icon will 
appear in the AMS Suite: Intelligent Device 
Manager to indicate that all configurations from 
the 375 Field Communicator can be accessed. 

2. In the AMS Suite: Intelligent Device Manager 
double-click the 375 Field Communicator icon. 
The Expansion Module and Internal Flash 
folders are displayed. Once all of the 
configuration files are displayed, perform your 
tasks with the AMS Suite: Intelligent Device 
Manager.

Easy Upgrade Programming Utility
To add Device Descriptions (DDs) or system 
software upgrades you will need to have a System 
Card with the Easy Upgrade option. For more 
details on use, see the Programming Utility online 
Help.

All 375 Field Communicators come with the basic 
ability to transfer event captures and text files 
using the Programming Utility.
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Using the 
ScratchPad 
application

From the 375 Main Menu double-tap ScratchPad 
to run the ScratchPad application. ScratchPad is a 
text editor that you can use to create, open, edit 
and save simple text (.txt) documents. You are 
able to transfer .txt files between a PC and the 375 
Field Communicator using the Programming Utility. 
ScratchPad only supports very basic formatting. 
You can also launch the ScratchPad application 
from within the HART or fieldbus application by 
tapping the ScratchPad ( ) icon in the upper 
right corner of the display. This will automatically 
open the ScratchPad application.

Once ScratchPad is launched you can perform the 
following operations. 

Figure 2-5.  Open blank document in ScratchPad
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Create a new document
From the Main Page in the ScratchPad application, 
tap the NEW button. An empty text window and 
SIP keypad will appear. You are now ready to enter 
text into your new document.

A new document can also be created within 
ScratchPad by tapping the New ( ) icon in the 
toolbar or by selecting File > New from the menu. 

Open an existing document
1. From the Main Page in the ScratchPad 

application, select the desired file located under 
File Name.

2. Tap the OPEN button. A text window and the 
SIP keypad will appear. You are now ready to 
edit your document. 

You can also open a document by selecting 
File | Open from the menu bar or by tapping the 
Open ( ) icon in the toolbar. 

Enter text 
Using the stylus, tap the desired letters from the 
SIP keyboard. Using the keypad, press the desired 
keypad button in quick repetitions to display the 
appropriate letter or number. 

Select text
Drag the stylus over the desired text to highlight, or 
to select all of the text in the document tap 
Edit | Select All....
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Cut text
1. Select the text to be cut.
2. Tap Edit from the menu bar.
3. Tap Cut from the Edit menu.

You can also cut text by selecting text and tapping 
the Cut ( ) icon in the toolbar. 

Copy text
1. Select the text to be copied.
2. Tap Edit from the menu bar.
3. Tap Copy from the Edit menu.

You can also copy text by selecting text and 
tapping the Copy ( ) icon in the toolbar.

Paste text
1. Copy the text to be pasted. 
2. Tap Edit from the menu bar.
3. Tap Paste from the Edit menu.

You can also paste text by copying the text to be 
pasted and tapping the Paste ( ) icon in the 
toolbar.

Undo text
1. In your document, tap Edit from the menu bar.
2. Tap Undo from the Edit menu.

Save a document
1. In your document, tap File from the menu bar.
2. Tap Save from the File menu.
3. Type the file name in the dialog box if your 

document is new.
4. Tap OK.

You can also save a document by tapping the 
Save ( )icon in the toolbar.
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Save a copy 
To save a copy of the current document under 
another name:
1. In your document, tap File from the menu bar.
2. Tap Save As... from the File menu.
3. Type the copy file name in the dialog box.

Delete a document
There are three options for deleting a ScratchPad 
document:

Option 1
1. From the Main Page in ScratchPad, select the 

file to be deleted. 
2. Tap DELETE.
3. A warning will appear telling you that the 

selected file will be permanently deleted. If you 
are sure you want to delete this file tap Yes.

Option 2
1. To delete from your document, tap File > Delete.
2. From the Delete File Page, tap the desired file to 

be deleted.
3. Tap OK.
4. A warning will appear telling you that the 

selected file will be permanently deleted. If you 
are sure you want to delete this file tap Yes.

5. Tap EXIT when you are finished deleting files.

Option 3
Delete the .txt file from the Programming Utility. 
See the Programming Utility online Help for more 
information. 

Exiting ScratchPad
1. In your document, tap File from the menu bar.
2. Tap Exit from the File menu.
3. Tap the EXIT button from the Main Page.
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MANAGING 
STORAGE

Types of 
storage

The 375 Field Communicator memory consists of 
four components:
1. Internal Flash—32MB non-volatile RAM. The 

Internal Flash memory stores the OS and 
system software. It also stores the following:

• Up to 25 HART configurations
• HART event captures
• FOUNDATION fieldbus statistics
• User generated text files
The optional Configuration Expansion Module 
(spare part number 00375-0043-0001) will allow 
you to store more than 25 configurations if needed; 
see below for more information.
2. System Card (SC)—an internal Secure Digital 

Card with non-volatile Flash memory. A copy of 
installable 375 Field Communicator system 
software exists on every System Card. The 
System Card also contains all HART and 
FOUNDATION fieldbus Device Descriptions.

3. RAM—32MB used only for program execution
4. Expansion Module (EM)— an optional 

removable memory card that snaps into the 
Expansion Port on the side of the 375 Field 
Communicator. The Configuration Expansion 
Module can store in excess of 500 HART 
configurations. 
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MAINTENANCE Any maintenance, repair, or replacement of 
components not listed below must be performed by 
specially trained personnel at authorized service 
centers. You can perform common maintenance 
procedures on the 375 Field Communicator, as 
described below: 
• Cleaning the exterior. Use only a dry lint-free 

towel or dampen the towel with a mild soap and 
water solution.

• Charging, removing, and replacing the battery 
pack

• Removing and replacing the System Card 
• Removing and replacing the Expansion Module 

or Expansion Port Plug
• Removing and replacing the stand assembly
• Ensuring that all exterior screws are sufficiently 

tightened
• Ensuring that the Communication Terminal 

recess is free of dirt and debris (does not require 
disassembly).

Battery 
Information

Checking the charge remaining
Use the Settings menu to check the charge 
remaining; see “Power” on page 2-13.

You can also check the battery charge remaining 
before you insert a spare battery pack. 
1. Remove the battery pack from the 375 Field 

Communicator; see “Removing the System Card 
and battery pack” on page 2-23.

2. Turn the battery pack over and press the battery 
pack charge indicator button. The indication 
lights will illuminate based upon the amount of 
charge remaining in the battery. Each light 
represents 20 percent of charge remaining. The 
battery is fully charged when all of the indicator 
lights are illuminated.
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Charging the battery
The battery can be charged while attached to the 
375 Field Communicator or charged separately. 
The indication light on the charger will be green 
when fully charged, amber when charging, cycle 
between amber and green when pulse charging, 
and red if it is unable to charge. 

Do not attempt to charge the battery pack in 
hazardous areas. To charge the 375 Field 
Communicator battery:
1. Plug the recharger/power supply into a power 

outlet.
2. Plug the power supply/charger connection into 

the 375 Field Communicator. The 375 Field 
Communicator is fully operable while the battery 
is recharging.

NOTE
The recharger/power supply may remain 
connected to the battery pack once it is fully 
charged. An overcharge condition will not occur.

Removing the System Card and battery pack
Remove the System Card and battery pack: 
1. Place the 375 Field Communicator face down on 

a level, secure surface.
2. Loosen the two battery pack retaining screws 

until the top of each screw is flush with the top of 
the battery pack.

3. Slide the battery off the main unit. Do not pull up 
on the battery pack as this could damage the 
power supply connector.

4. Grasp the System Card and slide it straight out 
of the main unit. Do not pull up on the System 
Card as this could damage the card or the 
System Card socket. 
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Running a self 
test

There is no need, nor is it possible, to perform a 
manual self test with the 375 Field Communicator. 
Testing features are done automatically. A warning 
message will occur if a fault condition is found 
during these tests.

Working in an 
Intrinsically 
Safe (IS) area

The battery pack can be replaced in an Intrinsically 
Safe area. The Expansion Module can be installed 
in an Intrinsically Safe area while the 375 Field 
Communicator is still running. 

Calibrating It is not necessary or possible to calibrate the 375 
Field Communicator. The 375 Field Communicator 
is a communication interface that communicates 
digitally with HART and FOUNDATION fieldbus 
devices. Voltage measurements made by the 375 
Field Communicator are for use in detection of 
power or noise on a network, and are for reference 
purposes only. Your 375 Field Communicator is not 
applicable to NIST standards and is not subject to 
calibration.

Waste 
disposal

If it ever becomes necessary to discard any part(s) 
of the 375 Field Communicator, adhere to the 
waste-disposal regulations applicable in your 
locality.
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00375-0047-0001, Rev. D
December 2004 375 FIELD COMMUNICATOR

SECTION 3 HART FUNCTIONALITY

OVERVIEW This section provides instruction on basic HART 
functionality of the Model 375 Field Communicator. 
It is based on the operation of the HART 
Application version 1.0. 

SAFETY 
MESSAGES

Procedures and instructions in this section may 
require special precautions to ensure the safety of 
the personnel performing the operation. 
Information that raises potential safety issues is 
indicated by a warning symbol ( ). Refer to the 
following safety messages before performing an 
operation preceded by this symbol. Other warning 
messages can be found in the Troubleshooting 
section of this manual. 

WARNING

If you choose to ignore all field device status messages, every message from nuisance to critical 
will be ignored. 

WARNING

Voltage measurements are for reference purposes only. Do not make critical process control 
decisions based upon this voltage.
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BASIC 
FEATURES 
AND 
FUNCTIONS

Interpreting the HART icon
A beating hollow heart icon is displayed when the 
375 Field Communicator is communicating with a 
live HART device ( ). A solid beating heart will 
replace the hollow heart icon when communicating 
to a HART loop with a device in burst mode. The 
HART logo is displayed during periods when 
communication is not occurring. This is common 
when only static parameters are listed.

STARTING 
THE HART 
APPLICATION

To start the HART application:
1. Turn on the 375 Field Communicator. The 375 

Main Menu is displayed with HART as the 
default application.

2. Double-tap HART Application. If a live HART 
device is connected to the 375 Field 
Communicator, the HART Application main 
menu will be displayed automatically with key 
parameters from the connected device. If a 
device is not connected, the HART Application 
main menu is displayed after a few seconds. To 
navigate back to the 375 Main Menu press the 
back arrow button. From the HART Application 
main menu you can choose Offline, Online, or 
Utility functions. The rest of this section will 
guide you through the HART Application menus 
and functions.

Using Fast Key 
sequences

The Fast Key sequence is a sequence of 
numerical button presses, corresponding to the 
menu options that lead you to a given task. The 
Fast Key sequences are identical to the 
sequences used on the 275 HART Communicator. 
See your field device documentation for fast key 
sequence options.
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Setting up Hot 
Key options

The Hot Key menu is a user-definable menu that 
can store shortcuts for up to 20 of your most 
frequently performed tasks. For example, if you 
change device tags and damping often, you can 
add options for these functions to the Hot Key 
menu. Once you are Online the Hot Key will 
automatically appear in the toolbar. To add a 
custom option to the Hot Key menu:
1. With the Online menu or any of the submenus 

open, select the option you want to add to the 
Hot Key menu.

2. Tap and hold the Hot Key ( ). The Hot Key 
Configuration window shows the new option you 
are adding.

3. Tap ADD.
4. Tap ALL to add the Hot Key option for all 

devices supported by the Communicator, or tap 
ONE to add the Hot Key option only for the 
device type to which you are currently 
connected.

5. If the message “Mark as read only variable on 
Hot Key menu” displays, choose one of the 
following:

• YES: The variable for this option is read-only, 
meaning users can view but not change its 
value.

• NO: You can view as well as change the value 
for this variable.

6. Respond to the message “Display value of 
variable on Hot Key menu?” by choosing one of 
the following:

• YES: The value of this variable will appear on 
the Hot Key menu.

• NO: The Hot Key menu will show the name of 
the variable but not its value.
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7. Tap the EXIT button on the Hot Key 
Configuration window to return to the original 
menu. The new option is added to the Hot Key 
menu.

Executing Hot 
Key options

To use a Hot Key option, you must first properly 
connect the 375 Field Communicator to a device. 
You can access the Hot Key menu from any online 
window. To use a Hot Key option:
1. Connect the 375 Field Communicator to a HART 

loop or device.
2. Tap the Hot Key. The Hot Key menu is 

displayed. 
3. Double-tap the desired option.

Removing Hot 
Key options 
one at a time

To remove individual Hot Key options:
1. Tap and hold the Hot Key ( ). The Hot Key 

Configuration window will appear.
2. Select the menu option you want to remove.

NOTE
Range Values is a predefined option and cannot 
be removed. It provides quick access for viewing 
or changing the range for a device.

3. Tap the DEL button.
4. When you are done, tap EXIT to close the Hot 

Key Configuration window.

Removing all 
Hot Key 
options

To remove all Hot Key options currently defined:
1. From the HART main menu, double-tap Utility.
2. From the HART Utility menu, double-tap 

Configure HART Application.
3. From the Configure HART Application menu, 

double-tap Storage Cleanup.
4. From the Storage Cleanup menu, double-tap 

Hot Key Menu.
5. Tap YES if you are sure you want to delete all 

the items from the Hot Key menu.
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WORKING 
OFFLINE

The Offline menu allows you to create offline 
configurations, view and change device 
configurations stored on the 375 Field 
Communicator.

There are two types of configurations: device 
configuration and user configuration. A HART 
configuration created from a HART device will 
initially be saved as a device configuration. A 
HART configuration created Offline will be saved 
as a user configuration. A HART configuration 
transferred to a 375 Field communicator from 
another program will be saved as a user 
configuration. Editing a device configuration within 
the 375 Field Communicator will change it to a 
user configuration. 

The concept of partial or standard configurations 
does not apply to the 375 Field Communicator. All 
configurations are full configurations.

Creating new 
configurations 
(Offline)

Creating a new configuration allows you to create 
a user configuration for a specific device type and 
revision. To create a new HART device 
configuration while working offline:
1. From the HART Application main menu, 

double-tap Offline.
2. From the Offline menu, double-tap New 

Configuration. The manufacturer names of the 
installed Device Descriptions are listed.

3. Double-tap the desired manufacturer to expand 
the list. The models available for the 
manufacturer are listed.

4. Double-tap the desired model to expand the list. 
The device revisions available for the selected 
model are listed.

5. Double-tap the desired device revision.
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6. If a warning appears, thoroughly read the 
warning, tap CONT. to accept the warning and 
proceed, or tap EXIT to end creating a new user 
configuration.

7. Mark the configurable variables you want sent to 
the HART device. Double-tap Mark all > OK to 
have all variables marked. Double-tap Unmark 
all > OK to clear the marks from all variables. A 
“+” symbol indicates a mark to send. A “*” 
symbol indicates a parameter has been 
edited.To mark and edit variables individually:
a.Double-tap Edit individually to configure 

specific variables before sending them to a 
device.

b.Scroll through the list of variables and select 
the variable you want to mark or edit.

c.To change the value for the selected variable, 
tap EDIT, change the value, and tap ENTER.

d.To mark the selected variable, tap MARK. A 
“+” symbol indicates a mark to send. A “*” 
symbol indicates a parameter has been edited.

e.Repeat steps b through d for other variables as 
necessary and tap EXIT when you are 
finished.

8. To save a new configuration, double-tap Save 
as... (The SAVE button will automatically bring 
you to the Save as... menu.)
a.To change the location where the configuration 

is saved, double-tap Location, select an 
option, and tap ENTER.

b.To specify a name for the configuration, 
double-tap Name, enter the name, and tap 
ENTER.

c.Tap SAVE. 
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Opening saved 
configurations 
(Offline)

Once opened, a saved configuration allows you to 
edit, copy to, send, delete, rename, and compare 
to other saved configurations. To open a saved 
configuration:
1. From the HART Application main menu, 

double-tap Offline.
2. From the Offline menu, double-tap Saved 

Configuration.
3. Double-tap the storage location from where you 

saved the configuration—Internal Flash 
Contents or Configuration Expansion Module 
Contents.

4. Double-tap the desired configuration to open the 
menu selection.

The FILTR button opens a menu that provides 
both sort and tag filter options. These options 
allow you to customize your view of saved 
device configurations. 

Sort allows you to group and display device 
configurations according to your choice of name, 
tag, or descriptor. 

Tag Filter allows you to customize your group for 
viewing according to what you entered with Sort 
by picking characters from the device name, tag, 
or descriptor. 

When setting up a filter, you can use two special 
characters: the period (.) and the asterisk (*). 
The period replaces a single character of any 
value. The asterisk is used to represent a string 
of alphanumeric characters of any value.

For example, if you want to list all configurations 
that have a tag or name of P - 001 to P - 300. 
You would enter “P - *” in the filter. If you want to 
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list configurations that have a tag or name that 
begins P- 0 and ends with a 7, set the filter to 
P - 0.7.

The XPAND button allows you to view the tag, 
manufacturer, device type, descriptor, and the 
configuration type. Tap CMPRS to return to the 
previous compressed screen.

Choose from the following menu options:

Edit a saved configuration (Offline)
Edit a saved configuration while working offline:
1. From the Saved Configuration menu, double-tap 

Edit.
2. If a warning appears, thoroughly read the 

warning, tap CONT. to accept the warning and 
proceed, or tap EXIT to end creating a new unit 
configuration.

3. Mark the configurable variables you want saved 
in the HART configuration. Double-tap 
Mark all > OK to have all variables marked. 
Double-tap Unmark all > OK to clear the marks 
from all variables. To mark and edit variables 
individually:
a.Double-tap Edit individually to configure 

specific variables before sending them to a 
device.

b.Scroll through the list of variables and select 
the variable you want to mark or edit.

c.To change the value for the selected variable, 
tap EDIT, change the value, and tap ENTER.

d.To mark the selected variable, tap MARK. A 
“+” symbol indicates a mark to send. A “*” 
symbol indicates a parameter has been edited.

e.Repeat steps b through d for other variables as 
necessary.

4. Tap SAVE to return to the Contents menu.
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Copy a saved configuration (Offline)
Copy to... allows you to copy a saved configuration 
to a new storage location.
1. From the Saved Configuration menu, double-tap 

Copy to....
2. Choose the storage location from which you 

want to open the configuration—Internal Flash 
or Configuration Expansion Module and tap 
ENTER.

3. Double-tap Name and enter the name of the 
configuration.

4. Tap SAVE to copy to a new location.

Send a saved configuration to a connected 
device
Send allows you to send the selected configuration 
to a connected device. From the Saved 
Configuration menu, double-tap Send. The 375 
Field Communicator will then send the 
configuration to a connected device that is 
compatible with the configuration.

Delete a saved configuration (Offline)
Delete allows you to remove configurations one at 
a time. To delete a configuration from the 375 Field 
Communicator storage:
1. From the Saved Configuration menu, double-tap 

Delete.
2. Tap Yes to confirm the deletion.
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Rename a saved configuration (Offline)
Rename allows you to change the name of a 
saved configuration. To rename a saved HART 
configuration:
1. From the Saved Configuration menu, double-tap 

Rename.
2. Double-tap the file you want to rename.
3. Enter the new file name and tap ENTER.
4. Tap SAVE.

Compare two saved configurations (Offline)
Any two configurations can be compared. 
However, in order to compare two configurations of 
the same field device, the following conditions 
must be met:
• Device type (including manufacturer), device 

revision, and DD revision must match exactly. A 
dialog box will appear if the configuration is 
different, however, you will not be told the 
differences.

• Configurations can only be compared against 
other configurations containing the same set of 
variables. The 375 Field Communicator notifies 
you if this condition is not met.

The format of data storage must match exactly. 
The 375 Field Communicator notifies you if this 
condition is not met.
1. From the Saved Configuration menu, double-tap 

Compare.
2. Choose the storage location—Internal Flash or 

Configuration Expansion Module and tap 
ENTER.

3. Double-tap Name to select the configuration file.
4. Double-tap the desired file to compare.
5. Tap COMP to compare the configurations.
6. Tap OK when you are finished reading the 

window.
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WORKING 
ONLINE

The online mode displays data for the HART 
device to which you are connected. The Online 
menu displays critical, up-to-date process 
information that is continuously updated, including 
device setup, primary variable (PV), analog output 
(AO), lower range value (LRV), and upper range 
value (URV). 

For information about intrinsically safe connections 
see Appendix B “Approval Information”.

A HART configuration created from a connected 
HART device will initially be saved as a 375 device 
configuration. Editing a device configuration within 
the 375 Field Communicator will change it to a 375 
user configuration. 

The 375 Field Communicator can communicate 
with a transmitter from the control room, the 
instrument site, or any wiring termination point in 
the loop.

Connecting to 
a HART loop

Connect the 375 Field Communicator with the 
appropriate connectors in parallel with the 
instrument or load resistor. The HART connections 
are not polarity sensitive.

In order for the 375 Field Communicator to function 
properly, a minimum of 250 ohms resistance must 
be present in the HART loop. 

NOTE
Dynamic variables shown while online represent 
the digital data being sent from the device. 
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There are three terminals on the top of the 375 
Field Communicator. Two of them are red and one 
of them is black. Each red terminal is a positive 
connection for its protocol. The black terminal is a 
common shared by both protocols. There is an 
access door to ensure that only one pair of 
terminals is exposed at any one time; see Figure 
3-1. There are several markings to indicate which 
pair of terminals is for which protocol. 

Figure 3-1.  HART terminal access door

HART Terminal Markings
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Figure 3-2 illustrates how to connect the 375 Field 
Communicator to a HART loop:

Figure 3-2.  Connecting to a HART loop

Figure 3-3 illustrates how to connect the 375 Field 
Communicator directly to terminals of a HART 
device:

Figure 3-3.  Connecting directly to a HART device
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The following diagram illustrates how to connect 
the optional 250-ohm resistor. Attaching a resistor 
is necessary if less than 250 ohms resistance is 
present in the HART loop. 

To temporarily install the optional 250-ohm load 
resistor:
1. Insert the load resistor into the lead set jacks.
2. Open the loop to allow connection of the resistor 

in series in the loop.
3. Close the loop using the lead set connectors.

VIEWING THE 
ONLINE MENU

The Online menu is the first menu to appear when 
connecting to a HART compatible device. It is 
structured to provide important information about 
the connected device. This menu displays critical, 
up-to-date device information including primary 
variable, analog output, lower range value, and 
upper range value. See your field device user’s 
manual for more information.

Optional 
250-Ohm Load 
Resistor

HART compatible 
device

Power
Supply

–+

–

+
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Because of the important information provided in 
the Online menu, some menus provide instant 
access to this window. When access is available, 
the HOME button appears to return you to the 
Online menu.

Figure 3-4.  Online menu example

Once you have made changes to the parameters, 
you may send them to the device. An asterisk will 
appear next to the parameter name of any un-sent 
item.

The configuration parameters for devices vary 
widely from device to device and are defined in the 
device description. Refer to your field device user’s 
manual for more information. To view process 
information for a connected device:
1. Connect the 375 Field Communicator to a HART 

loop or directly to the device.
2. Push the on/off button to turn on the 375 Field 

Communicator.
3. Double tap HART Application. The Online main 

menu will be displayed automatically.
4. You can view more information about these 

parameters by choosing the following Online 
menu options:
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Viewing the 
Device Setup 
submenu

The Device Setup menu accesses every 
configurable parameter of the connected device. 

The Online menu displays critical process 
information that is continuously updated. If the 
primary variable and related engineering units are 
too long, they will not appear on the Online menu. 
Double-tap to view the item and the related 
engineering units when it appears truncated on the 
Online menu.

Double-tap Device setup to view the process 
variables, diagnostics and service, basic setup, 
detailed setup, and review:

Process Variables (PV)
The PV menu lists all process variables and their 
values. Process variables are continuously 
updated when this screen is displayed. 

Diagnostics and service
The Diagnostics and Service menu offers device 
and loop tests as well as calibration options. The 
diagnostics and service operations that are 
available vary widely from device to device and are 
defined in the device description.

Test device menu lists the status as well as self 
and master test of the device. Test device initiates 
a diagnostic routine at the device and can report 
an electronics failure, as well as other failures that 
can affect performance. 

Loop test is used to set the output of the device at 
a specified analog value, and may be used to test 
the integrity of the loop and the operation of 
indicators, recorders, or similar devices in the loop. 

Calibration is used to perform such operations as 
performing a sensor trim, D/A trim, and scaled D/A 
trim.
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Basic setup
The Basic setup menu provides quick access to a 
number of configurable parameters including tag, 
unit, range values, and damping. 

The options available in the Basic setup menu are 
the most fundamental tasks that can be performed 
with a given device. These tasks are a subset of 
the options available under the Detailed setup 
menu.

The Tag alphanumeric identifies a specific device. 
Changing units affects the engineering units that 
are displayed. Reranging changes the analog 
output scaling. Changing damping effects the 
response time of the transmitter and is often used 
to smooth the output when there are rapid input 
variations.

Detailed setup
The Detailed setup menu provides access to every 
editable device parameter and all device functions. 
The Detailed setup menu varies widely from one 
HART compatible device to another. Functions in 
this menu can include tasks such as 
characterization, configuration, and sensor and 
output trims.

Review 
The Review menu lists all of the static parameters 
read from the connected device, including 
information about the device and sensor setup and 
limitations. It also includes information about the 
connected device such as tag, materials of 
construction, and device software revision.
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Configuring 
the HART 
application

Changing the HART polling option
Use the HART polling option to configure your 375 
Field Communicator to automatically search for all 
or specific connected devices. Most HART device 
installations contain one device per loop and the 
device address equals zero.

To have more than one device per loop, wire the 
devices in parallel and placed into “Multidrop” 
mode. This mode is enabled by changing the 
address from zero to any address between
1 — 15. After the mode is enabled, the analog 
output of each device is fixed and no longer 
represents any variable.

To change the polling option:
1. From the HART main menu, double-tap Utility.
2. Double-tap Configure HART Application.
3. Double-tap Polling.
4. Select one of the following polling options:
• Never Poll - Connects to a device at address 0 

and if not found, it will not poll.
• Ask Before Polling - Connects to a device at 

address 0 and if not found, you will be asked if 
you want the communicator to poll for devices at 
addresses 1–15.

• Always Poll - Connects to a device at address 0 
and if not found, the communicator will 
automatically poll for devices at addresses 1–15.

• Digital Poll - Polls addresses 0–15, regardless if 
a device is found at address 0. To find individual 
device addresses, use this option to find each 
connected device in the loop and list them by tag 
number.

• Poll Using Tag - Allows you to enter the tag of 
the device. You will be prompted to enter a tag 
name upon starting the HART Application.
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• Poll Using Long Tag - Allows you to enter the 
long tag of the device. You will be prompted to 
enter a tag name upon starting the HART 
Application. (Only supported in HART Universal 
revision 6 devices.) Double-tap when the tag is 
truncated to display the full tag. 

5. Tap Enter.
Refer to your device-specific manual for 
information about changing a device polling 
address.

Changing ignored status messages
The 375 Field Communicator displays status 
messages from the HART device it is 
communicating with. The Ignore Status option lets 
you specify the number of field device status 
messages that are ignored, extending the time 
between displayed messages. The default is 50 
messages. If you choose to ignore all field device 
status messages, every message from nuisance to 
critical will be ignored. 

To change the number of ignored status 
messages:
1. From the HART main menu, double-tap Utility.
2. Double-tap Configure HART Application.
3. Double-tap Ignore Status.
4. Enter the number of status messages you want 

ignored before the next message is displayed. 
You can specify a number from 50 to 500.

5. Tap ENTER. All field device status messages 
will be ignored until the quantity specified has 
been reached.
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Storage Cleanup
The Storage Cleanup menu lets you delete the 
following items:
• Internal Flash - By selecting YES you will 

remove all configurations saved in the Internal 
Flash.

• Configuration Expansion Module - By 
selecting YES you will remove all configurations 
saved in the Configuration Expansion Module. 

• Hot Key Menu - By selecting YES you will 
delete all items from the Hot Key menu. 

Viewing available Device Descriptions
HART Device Descriptions enable the 375 Field 
Communicator to recognize and configure specific 
HART-compatible devices. To view the currently 
installed HART Device Descriptions:
1. From the HART main menu, double-tap Utility.
2. Double-tap Available Device Descriptions. 

The manufacturer names of the installed Device 
Descriptions are listed.

3. Double-tap the desired manufacturer to expand 
the list. The models available for the 
manufacturer are listed.

4. Double-tap the desired model to expand the list. 
The device revisions available for the selected 
model are listed.

375_Man_RevD.book  Page 20  Wednesday, December 1, 2004  11:40 AM



HART Functionality 3-21

Simulating an 
online 
connection to 
a HART device

The 375 Field Communicator has a simulation 
mode that allows you to simulate an online 
connection to a HART-compatible device without 
actually connecting to a device. Simulation mode is 
a training tool that helps you become familiar with 
devices before configuring them in a critical 
environment. A simulated configuration cannot be 
saved. Not all DDs have been optimized to run 
under simulation.

To simulate a connection to a HART device:
1. From the HART main menu, double-tap Utility.
2. Double-tap Simulation. The manufacturers with 

device descriptions installed on the 375 Field 
Communicator are listed.

3. Double-tap the desired manufacturer to expand 
the list. The models available for the 
manufacturer are listed.

4. Double-tap the desired model to expand the list. 
The device revisions available for the selected 
model are listed.

5. Double-tap the desired device revision. Refer to 
the device manual to determine the device 
revision.

6. If a warning appears, thoroughly read the 
warning, tap CONT. to accept the warning and 
proceed, or tap EXIT to end creating a new unit 
configuration. (This warning will not appear if 
your device is tested.) The online menu for the 
simulated device is displayed. You can now use 
the 375 Field Communicator as if it were 
connected to the selected device and perform 
any online task. 

375_Man_RevD.book  Page 21  Wednesday, December 1, 2004  11:40 AM



HART Functionality3-22

Viewing HART 
diagnostics

DC voltage measurement (HART terminals)
To check the device voltage:
1. From the HART main menu, double-tap Utility.
2. Double-tap HART Diagnostics.
3. Double-tap DC Voltage Measurement. The DC 

voltage measurement is displayed. Tap OK 
when done viewing the measurement. Exit the 
HART Terminal Voltage menu and re-enter to 
refresh the screen. Voltage measurements are 
for reference purposes only.

Disconnecting 
from a HART 
device

Prior to disconnecting be sure to check the 
following items:
• Determine if you want to save as a configuration.
• Verify methods (e.g., calibration, loop test) are 

complete.
• Resolve any un-sent data to the device. 
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SECTION 4 FIELDBUS FUNCTIONALITY

OVERVIEW This section provides instruction on basic fieldbus 
functionality for the 375 Field Communicator. It is 
based on the operation of FOUNDATION Fieldbus 
Application version 2.0.

SAFETY 
MESSAGES

Procedures and instructions in this section may 
require special precautions to ensure the safety of 
the personnel performing the operation. 
Information that raises potential safety issues is 
indicated by a warning symbol ( ). Refer to the 
following safety messages before performing an 
operation preceded by this symbol.

WARNING

There could be a Database Mismatch. Ensure all safety precautions and work procedures have 
been followed. 

If this segment is connected to a Host System, the changes made with the 375 may not be 
recorded in the Host System’s permanent data base. Verify the changes in the database. 
Otherwise, this could cause unpredictable results and, depending upon your application, 
process disruption leading to property damage, serious injury, or death.

WARNING

Process control could be affected. Changing device parameters could adversely affect the 
control of your process. 

Ensure all safety precautions and work procedures have been followed. Put control loop in 
Manual/Out of service before applying changes. Verify output before returning control loop to 
Auto. Failure to do so could result in property damage, death or serious injury.
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BASIC 
FEATURES 
AND 
FUNCTIONS

Link Active 
Scheduler 
(LAS)

All segments have one and only one Link Active 
Scheduler (LAS). The LAS operates as the bus 
arbiter for the segment. The 375 Field 
Communicator is set up to always be the last node 
to become the LAS on a segment.

The devices that are capable of becoming the LAS 
are called link master devices. All other devices 
are referred to as basic devices. When a segment 
first starts up, or upon failure of the existing LAS, 
the link master devices on the segment bid to 
become the LAS. The link master that wins the bid 
(i.e., the one with the lowest address) begins 
operating as the LAS immediately upon 
completion of the bidding process. Link masters 
that do not become the LAS can act as LAS 
backups by monitoring the segment for failure of 
the LAS and then bidding to become the LAS 
when a LAS failure is detected.

Although the 375 Field Communicator is capable 
of becoming the LAS, it does not maintain the 
communication schedule and should not be 
thought of as a backup LAS.

Only one device can communicate at a time. 
Permission to communicate on the bus is 
controlled by a centralized token passed between 
devices by the LAS. Only the device with the token 
can communicate. The LAS maintains a list of all 
devices that need access to the bus. This list is 
called the Live Device List; see “Displaying the 
Live Device List” on page 4-11.
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Device 
Interoperability 

The 375 Field Communicator is designed to 
operate with a wide range of FOUNDATION fieldbus 
devices independent of device manufacturer. 
Device interoperability is achieved through the use 
of Device Description Language (DDL) technology 
supported by the Fieldbus Foundation. 

Basic testing is performed on all DDs. In addition, 
each device manufacturer is asked to certify that 
they have thoroughly tested their device(s) with the 
375 Field Communicator. If certification is not 
received, a warning message will display when you 
attempt to access an untested device.

LAS Hierarchy When a 375 Field Communicator is connected to a 
live fieldbus segment, it joins the fieldbus segment 
but not as the LAS. This means that, although the 
375 Field Communicator can view and edit device 
parameters, the control of the segment is still 
handled by the node that is designated the LAS for 
the segment. You can also read and write if there is 
another LAS. Prior to connecting to a host system 
review the 375 Field Communicator Host System 
Interoperability on www.fieldcommunicator.com.

ST_REV ST_REV is a block parameter that increments 
each time a block configuration has changed. 
While a list of parameters is displayed, the 375 
Field communicator will continuously read the 
ST_REV of that particular block. If it sees the 
ST_REV counter has incremented, it knows that 
there has been a change to the block, and it will 
automatically refresh (reread) all of the block 
parameters. Thus, there would only be a very short 
period of time before a change made by another 
host would appear on the 375 display.
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Modes The Resource, Transducer, and all function blocks 
in the device have modes of operation. These 
modes govern the operation of the block. Every 
block supports both automatic (AUTO) and out of 
service (OOS) modes. Other modes may also be 
supported.

Types of Modes

For the procedures described in this manual, it will 
be helpful to understand the following modes:

AUTO
The functions performed by the block will 
execute. If the block has any outputs, these 
will continue to update. This is typically the 
normal operating mode.

MAN
In this mode, the output of the block can be 
manually overwritten for testing purposes.

Out of Service (OOS)
The functions performed by the block will 
not execute. If the block has any outputs, 
these will typically not update and the status 
of any values passed to downstream blocks 
will be “BAD”. Before you make changes to 
the configuration of the block, change the 
mode of the block to OOS. When the 
changes are complete, change the mode 
back to AUTO.

Other Types of Modes
Other types of modes are Cas, RCas, ROut, 
IMan and LO. For more information; see the 
Emerson Process Management, 
Rosemount Division Function Block manual, 
document 00809-0100-4783.
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Locating Mode Parameters
In the Resource and Transducer blocks, the mode 
parameters are normally found in the Process 
menu. In all other Function blocks, they are found 
in the Common Config. menu. The Mode 
parameters will also be included in the All 
parameter list; see “Working with Device Blocks” 
on page 4-13.

Changing Modes
A warning message may appear whenever the 
mode of any block is included in a list of parameter 
changes to be sent to a device. Press YES to send 
the change, or NO to not send the change. 

To change the operating mode, set the 
MODE_BLK.TARGET to the desired mode. After a 
short delay, the parameter 
MODE_BLOCK.ACTUAL should reflect the mode 
change if the block is operating properly. 

Permitted Modes
It is possible to prevent unauthorized changes to 
the operating mode of a block. To do this, 
configure MODE_BLOCK.PERMITTED to allow 
only the desired operating modes. It is 
recommended to always select OOS as one of the 
permitted modes.

375_Man_RevD.book  Page 5  Wednesday, December 1, 2004  11:40 AM



Fieldbus Functionality4-6

STARTING 
THE 
FIELDBUS 
APPLICATION

A general warning message may appear upon 
starting the Fieldbus Application when an LAS is 
detected on the segment. Select YES to proceed 
to the Live Device List, NO to return to the 375 
Main Menu, or HELP to get more information on 
the warning. 

To start the fieldbus application:
1. Turn on the 375 Field Communicator. The 375 

Main Menu is displayed; see Figure 4-1.
2. Double-tap FOUNDATION Fieldbus Application. 

If a live fieldbus device is connected to the 375 
Field Communicator, the Fieldbus Application 
main menu will briefly display followed by the 
Live Display List. 

If insufficient voltage is detected, a warning will 
appear saying “No FF Segment Voltage 
Detected. Press OK to go to the FF Main Menu.” 
Press OK to navigate to the Fieldbus Application 
main menu.

Figure 4-1.  Fieldbus Application menu screen example

A connection warning message may appear if no 
communication is detected. This means that an 
LAS is not recognized by the segment and typically 
occurs when connecting to a single device. 
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To navigate back to the 375 Main Menu, press the 
back arrow button. From the Fieldbus Application 
main menu you can choose Online, Utility or 
Fieldbus Diagnostic functions. The rest of this 
section will guide you through the Fieldbus 
Application menus and functions.

Digital communication is susceptible to electrical 
noise; follow proper wiring instructions.

WORKING 
ONLINE

The online menu displays data for the device to 
which you are connected. The Online menu 
displays critical, up-to-date process information, 
including the segment Live Device List, block lists, 
and parameter functionality. For information about 
intrinsically safe connections see Appendix B 
“Approval Information”.

NOTE
It is normal for processes to take longer the greater 
the amount of scheduled communication. This is 
influenced by the number of devices and the 
control methods in place.

Connecting to 
a fieldbus loop

Connect the 375 Field Communicator with the 
appropriate connectors in parallel with the 
instrument. Due to measurement circuitry the 375 
Field Communicator fieldbus connections are 
polarity sensitive. If connected incorrectly, an error 
message will display.

NOTE
Dynamic variables shown while online represent 
the digital data being sent from the device. 
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There are three terminals on the top of the 375 
Field Communicator. Two of them are red and one 
of them is black. Each red terminal is a positive 
connection for its protocol. The black terminal is a 
common shared by both protocols. There is an 
access door to ensure that only one pair of 
terminals is exposed at any one time; see Figure 
4-2. There are several markings to indicate which 
pair of terminals is for which protocol. 

Figure 4-2.  Fieldbus terminal access door

Fieldbus Terminal Markings
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Bench hook-up
The following diagram illustrates one method of 
connecting the 375 Field Communicator on a 
bench. 

For segments that are limited in size, the power 
conditioner and terminators can be contained in a 
single wiring block.

Figure 4-3.  Bench wiring diagram example
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Field hook-up
The following diagram illustrates one method of 
connecting the 375 Field Communicator to a 
fieldbus segment. The 375 Field Communicator 
can be connected at any convenient place along 
the bus (segment). In the field, this is typically done 
at the device or at the fieldbus junction box.

Figure 4-4.  Field wiring diagram example

NOTE
The 375 Field Communicator draws approximately 
17 ma from the fieldbus segment.  Be sure that the 
power supply or barrier on the fieldbus segment 
has the capacity to provide this additional current.  
If a heavily loaded fieldbus segment is drawing 
near the capacity of the segment’s power supply, 
connecting the 375 may result in loss of 
communication.
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Displaying the 
Live Device 
List

To display the active devices on a Fieldbus 
segment (Live Device List):
1. Connect the 375 Field Communicator to a 

Fieldbus segment.
2. Turn on the 375 Field Communicator. 
3. On the main menu, double tap FOUNDATION 

Fieldbus Application.
4. On the Fieldbus Application menu, choose 

Online. The Fieldbus Live Device List displays.
If a live fieldbus device is connected to a host 
acting as the LAS, a precautionary message will 
appear, then the Live Device List will be 
displayed automatically with key parameters 
from the connected device. If an existing host 
control system or a device capable of being the 
LAS is not connected, the 375 Field 
Communicator will act as a temporary LAS on 
the segment and produce a warning message. 
After reading and following the message 
instructions, press OK to display the Live Device 
List.

Figure 4-5.  Live Device List screen example
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Displaying the 
Block List

The Block List view lists the block tag, block type, 
and actual mode of the device blocks, as well as 
Schedule, Advanced, and Detail information 
contained in a particular device. Consult your 
device manual or the Fieldbus Foundation for more 
information on blocks. FOUNDATION fieldbus menu 
trees will be on www.fieldcommunicator.com as 
they become available. To view the Block List:
1. From the Fieldbus Application menu, choose 

Online. The Fieldbus Live Device List will 
appear.

2. Double tap the device you want to work with. A 
status line appears on the bottom of the screen 
to indicate connection progress.

Figure 4-6.  Block list screen example
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Working with 
Device Blocks

The block menu is a submenu of the block list. 
Block menus display block information for the 
fieldbus device to which you are connected. 

If the DD is not installed in your 375 Field 
Communicator a DD error will appear. New DDs 
will be made available on a regular basis; see 
“Easy Upgrade Programming Utility” on page 2-16.

Devices that do not support transducer block 
menus within the DD will have the following 
selections: All, Process, Status, Other. If Methods 
are incorporated into the transducer block they will 
be displayed as either Diagnostic Methods or 
Calibration Methods. Tap All to display all of the 
parameters for the desired block. ALL display call 
up times may take several minutes. It is 
recommended you use this only if you are unable 
to find your desired selection elsewhere.

If the device DD supports menus, you can display 
the block menu by performing the following steps:
1. Display the block list; see page 4-12.
2. Double tap the desired block tag and the block 

menu will appear.
3. From the block menu double tap the desired 

parameter group label category. 

NOTE
The Block mode must be in the appropriate state to 
accept parameter changes. Typically the mode is 
MAN or OOS. 
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Parameter Functionality
Shaded areas indicate values that cannot be 
changed. In initial versions of the Fieldbus 
Application you will be able to edit only the 
resource, transducer, and I/O blocks. You will be 
able to open and view all other blocks, however, 
you will not be able to edit them.

Modified Parameters
An asterisk will appear next to a modified 
parameter which has not yet been sent to 
the device.

Displaying block parameters for
fieldbus devices
To display the parameters for fieldbus 
devices:
1. Display the Live Device List; see 

page 4-11.
2. Double tap a device on the Live Device 

List to view the blocks in that device. 
3. Double tap the desired block.
4. Double tap the desired parameter group. 

The parameters and their current values 
are displayed. Shaded areas indicate 
values that cannot be edited.

Changing and sending parameter data
To change the values for parameters:
1. Display the parameters for fieldbus 

devices.
2. Double tap the desired parameter.
3. Change the value for the parameter.

(Tap HELP to view a description of the 
parameter.)

4. Tap OK to acknowledge the parameter 
change. Repeat these steps for other 
parameters as necessary. A “*” symbol 
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indicates a parameter has been edited.
5. Tap SEND to commit your changes to the 

connected fieldbus device.

Running methods (e.g., calibrations, sensor 
trim, diagnostic, etc.)
Select submenu choices as appropriate. Different 
devices have different methods associated with 
them. The selections on these menus vary 
accordingly.
1. Display the Live Device List; see page 4-11.
2. Double tap a device from the Live Device List.
3. Double tap the desired block (typically methods 

are run in the Transducer block).
4. Double tap Methods.
5. Double tap the type of method you want to run, 

e.g., calibration, diagnostic. Follow the 
navigation screens to run the method.

Displaying Device status
To display device status:
1. Display the Live Device List; see page 4-11.
2. Double tap a device from the Live Device List.
3. Double tap the desired block.
4. Double tap Status. Status parameter(s) will be 

displayed.

Other Block 
List selections

Detail Menu
To view the Detail menu:
1. Display the Live Device List; see page 4-11.
2. Double tap the device you want to work with. 
3. Scroll down the block list and double tap Detail. 

Double tap one of the following options:
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• Physical Device Tag designates a field device’s 
role in the system. It is not recommended to 
change the device tag when the device is 
connected to a control system. Changing the 
Physical Device Tag on a device which is on an 
active segment could have unpredictable results.

• Address is the data link layer node address of 
the device. The Host Control System has the 
ability to assign an address to a device when it is 
connected to a segment. If the 375 Field 
Communicator is not the LAS on the segment, 
changing the address could have unpredictable 
results. It is not recommended to change the 
address when the device is connected to a 
control system. The following should be taken 
into consideration when assigning device 
addresses:

• Valid device addresses for fieldbus 
devices are 20 through 247 with the 
exception of the addresses between 
V(FUN) and V(FUN) + V(NUN)-1 as 
defined for the 375; see “Polling” on 
page 4-18. These parameters are 
available in the Polling menu.

• Addresses between 16 and 19 are usually 
reserved for host systems. A device 
should not be assigned in this address 
range.

• Addresses below 16 are not available.

• Addresses between 248 and 251 are 
temporary addresses. Devices without a 
Tag or address will come up on the 
segment at these addresses.

• Addresses in the range 252 to 255 are 
reserved for visitors such as the 375 itself.
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• Device ID is the unique number identifier for 
each device. It is set by the device manufacturer 
and cannot be changed.

• Device Revision is the manufacturer revision 
number. It is used by an interface device to 
locate the DD file for the resource and cannot be 
changed.

4. Using the SIP keyboard, enter the new 
information. Tap OK.

Changing the I/O block schedule
To change the schedule:
1. Display the Live Device List; see page 4-11.
2. Double tap the device you want to work with. 
3. Scroll down the block list and double tap 

Schedule. The I/O Block Schedule window will 
appear. Changing the I/O block schedule on a 
device which is on an active segment running 
control could have unpredictable results. 
Changing the I/O Block Schedule would typically 
be done on the bench (not connected to a 
control system) when you want to execute an I/O 
block to verify that the outputs of the block are 
being computed correctly.

4. Using the drop down menu, select the 
appropriate MacroCycle (1, 2, 5, or 10 seconds).

5. Tap to check the box next to the I/O blocks that 
are to be scheduled.

6. Tap OK. This will schedule the blocks and set 
the mode on these blocks to Auto.

7. After reading the note, tap OK to acknowledge 
that the I/O Block(s) were successfully 
scheduled.
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Displaying advanced features
To view the advanced features, including Network 
Parameters:
1. Display the Live Device List; see page 4-11.
2. Double tap the device you want to work with. 
3. Scroll down the block list and double tap 

Advanced. Double tap the desired Label to view 
label values.

You can save these values to an electronic file to 
better facilitate network troubleshooting. These 
files can be transferred to a PC using the Easy 
Programming Utility.

UTILITY The Fieldbus Application Utility menu displays 
polling, link settings, and the available device 
description list installed on the 375 Field 
Communicator.

Polling The V(FUN) is the first unpolled node address. 
V(NUN) is the number of unpolled node 
addresses. The addresses between V(FUN) and 
V(FUN)+V(NUN)-1 are not polled. The default 
value for V(FUN) is 200 and the default value for 
V(NUN) is zero.

The DeltaV System checkbox instructs the 375 
Field Communicator to use the same polling 
scheme as DeltaV. 

Enter the desired polling addresses in the 
appropriate field. Narrowing the range of devices 
being polled provides a quicker Live Device List 
refresh.
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Link Settings Slot Time
Select the default Slot Time of eight to allow the 
devices to be seen on the 375 Field Communicator 
Live Device List. It may be necessary to change 
the Slot Time to 16 in order to view older devices 
on the 375 Field Communicator Live Device List. 
For a list of the affected devices see 
www.fieldcommunicator.com. 

Available 
Device 
Description 
List

To view fieldbus device descriptions installed on 
the 375 Field Communicator:
1. On the Fieldbus Application menu, double tap 

Utility.
2. Double tap Available Device Description List. 

Fieldbus device manufacturers are listed.
3. Double tap the manufacturer of the device you 

want to view. The models available for the 
manufacturer are listed.

4. Double tap the model of the device description 
you want to view. The device revisions available 
for the selected model are listed. Untested DDs 
are indicated by a  symbol. 

FIELDBUS 
DIAGNOSTICS

Fieldbus diagnostics run diagnostics for 
troubleshooting fieldbus networks. To view the 
Fieldbus Diagnostics menu:
1. From the Fieldbus Application menu, double tap 

Fieldbus Diagnostics.
2. If a warning appears, read it and tap OK to 

acknowledge.
3. To perform a measurement, tap the check box 

beside your desired option(s). Tap START to 
view the Diagnostic Results.
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To retrieve information about a test, highlight the 
test and press HELP.

If Auto Re-test was not selected on the Fieldbus 
Diagnostics screen, tap RETEST to perform a 
single re-test.

Figure 4-7.  Fieldbus Diagnostics screen examples

Disconnecting 
from a 
Fieldbus 
Device

Prior to disconnecting or turning off the 375 Field 
Communicator be sure to check the following 
items:
• Verify methods (e.g., calibration) are complete.
• Resolve any un-sent data to the device.
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USER’S MANUAL
00375-0047-0001, Rev. D
December 2004 375 FIELD COMMUNICATOR

SECTION 5 TROUBLESHOOTING

OVERVIEW This section provides basic troubleshooting 
techniques for the Model 375 Field Communicator. 

Below are methods for troubleshooting networks 
that are experiencing problems communicating 
between a field device and the 375 Field 
Communicator.

Troubleshooting 
suggestions

Answer the questions below and use the 
troubleshooting tables, Table 5-4 and Table 5-5, 
before calling technical support personnel.
• Does the control system have HART or fieldbus 

communication capabilities? 
• Is it configured to communicate HART or fieldbus 

currently? Is it reporting communication 
problems? If not, stop communications on the 
control system and test communication with the 
375 Field Communicator again. 

• Is there a barrier installed?
• Is the barrier capable of passing along the 

signal? 
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Loops
Verify the HART loop current and voltage on the 
field device. Almost all field devices need at least 
4mA and 12VDC to operate properly.

If there are multiple field devices on a multidrop 
loop then set the 375 Field Communicator to digital 
polling mode.

Inspection of the loop wiring can often times reveal 
problems. The shield is normally grounded at one 
end only, which is usually the control system. 

Verify that the loop has a minimum of 250 ohms 
resistance. If there is not an external resistor, then 
normally, the total resistance is the resistance of 
the process-indicating device monitoring the loop. 
Check the manuals for the process-indicating 
device to determine its loop resistance. If the 
resistance of the process-indicating device is 
unknown it can be determined by knowing the 
current flow in the loop and the voltage across the 
process-indicating device. 

The resistance can be calculated using the 
formula, Resistance = Voltage / Current. The 375 
Field Communicator can be used to measure the 
voltage; see “DC voltage measurement (HART 
terminals)” on page 3-22.
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Sample values
Loop Current Flow Minimum voltage for 250 ohms.

4 ma 1 Volt
8 ma 2 Volts
12 ma 3 Volts
16 ma 4 Volts 
20 ma 5 Volts

If the voltage across the process-indicating device 
is greater than the value listed for a given current 
flow then the device has at least 250 of internal 
resistance. If the voltage is less than the value 
listed on the table for the given current flow, then 
more resistance needs to be added to the loop. 

If an oscilloscope is available for use then use it to 
look for noise on the loop. It is necessary to use a 
a scope with differential mode capability or a 
battery powered/isolated scope to avoid grounding 
one side of the loop. Noise with a frequency of 500 
Hz to 10,000 Hz is of particular interest, as this 
represents frequencies near the HART frequencies 
of 1200 and 2200 Hz.
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Table 5-1.  Troubleshooting table for HART protocol

Symptom Possible Causes Solution

Intermittent communication Insufficient loop 
current and voltage at 
the field device 
terminals.

Verify that there is at least 4mA and 12V DC 
at the field device terminals; see “DC 
voltage measurement (HART terminals)” on 
page 3-22.

Noise on the field loop

Noise or signal 
distortion from the 
control system (i.e., 
noise from the power 
supply powering field 
devices or front end 
analog circuitry inside 
of control system may 
be distorting the HART 
signal.

Poor wiring Check wiring terminations and exposed 
signal wire for damage.

No communication with 
field device.

Insufficient loop 
resistance at the HART 
frequencies.

Add an additional 250 ohm resistor in series 
in the loop. Place the leads across the 
resistor and verify if communication has 
been restored.

Insufficient loop 
current and voltage at 
the field device 
terminals.

Verify that there is at least 4mA and 12V DC 
at the field device terminals; see “DC 
voltage measurement (HART terminals)” on 
page 3-22.

Field device may be 
set to HART address 
other than zero 
(multi-drop mode). 

Change Polling mode to something other 
than never poll, e.g., Digital Poll.

Control system is 
communicating HART, but 
the 375 is not 
communicating properly. 

HART communication 
is being prevented by 
the control system.

Stop HART communications on the control 
system and verify if communication between 
the field devices and the communicator is 
restored.
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Table 5-2.  Troubleshooting table for fieldbus protocol

Symptom Possible Causes Solution

No communication with 
field device.

The 375 is connected 
to a segment with 
DeltaV and the device 
on the same segment 
is being commissioned 
using DeltaV.

The 375 will be unable to communicate with 
this device until you go offline and then back 
online.

Connection to a segment in 
a bench configuration and 
the Live Device List 
remains blank (even the 
375 Field Communicator 
does not appear).

This issue is caused by 
the speed at which 
certain LAS enabled 
devices are attempting 
to run the segment.

Establish communication by putting the 375 
on the segment first and then adding the 
device(s). By putting the 375 on first, it will 
remain the LAS and control the 
communication.

Unable to change the 
address of a device.

The 375 is unable to 
change the address of 
a device that is 
currently the LAS.

Establish communication by putting the 375 
on the segment first and then adding the 
device(s). By putting the 375 on first, it will 
remain the LAS and allow the address 
change.

The 375 does not remain 
the LAS on a segment.

A Host takes over as 
the LAS.

When a Host is established on a segment, it 
will take over as the LAS. No action is 
required.

A backup LAS takes 
over as the LAS. The 
lower the address and 
Slot Time of the 
device, the more likely 
this will occur.

See “Slot Time” on page 4-19 and “Other 
Block List selections” on page 4-15.
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ERROR AND 
STATUS 
MESSAGES

General Error Messages Description

License file check failed - error code x. Please contact 
service center to resolve this problem. 
Press OK to turn off. (Where x indicates the test that 
failed.)

License file check failed during 
power- up

Battery power is less than 5%. You must recharge the 375 
battery, switch to a spare battery pack, or use external 
power. Press OK to turn off.

The power-up battery check detects 
the battery charge is below five 
percent while on battery.

Battery power is less than 20%. You may need to recharge 
the 375 battery, switch to a spare battery pack, or use 
external power.

The power-up battery check detects 
the battery charge is below 20%, and 
more than or equal to 5% while on 
battery.

Communication circuit is not responding. CDC is not responding during the 
power-up

Warning: System incompatibility detected - error code x.
You may start Listen for PC and use the 375 Programming 
Utility to resolve this. Or
You may turn off your 375 and contact service center to 
resolve this. (Where x is an error code indicating what the 
incompatibility detected was or related errors.)

Hardware version or Operating 
System is not compatible.

Installation file is corrupt - error code x. Please call service 
center to resolve this problem. Press OK to turn off. 

The installation is corrupt.

The 375 needs to update its software. Battery power must 
be more than 20% to allow for this update. You must 
recharge the 375 battery, switch to a spare battery pack, or 
use external power. Press OK to turn off. 

This message occurs when on 
battery, and the battery percentage is 
less than 20% before attempting to 
launch program loader:

This 375 is not licensed for HART. You are not licensed for HART 
functionality.

This 375 is not licensed for FOUNDATION Fieldbus. You are not licensed for FOUNDATION 
fieldbus functionality.

The 375 does not detect a System Card. Please make sure 
your System Card is properly installed in its slot. Press OK 
to turn off. 

This message occurs when the 
System Card is not properly installed 
in its slot.
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HART Error and Help Messages Description

"Poll Using Long Tag" allows the user to enter the long tag 
of the device they want to connect to

This is a help message.

"Poll Using Tag" allows you to enter the tag of the device 
you want to connect to

This is a help message.

Enter Device Long Tag This is a help message.

Enter the long tag that corresponds to the device you want 
to connect to

This is a help message.

Hart Application Error... “hc.ddl device revision x not 
found.”...Refresh System Card...See User's Manual and 
Programming Interface for details

This error message appears when an 
expected version of hc.ddl is not 
found.

Hart Application Error... “registry failure”...Reinstall System 
Files...See User's Manual for details

This error message appears when 
the information describing the 
location of the DD's is not found in 
the registry.

Voltage is currently detected at the Fieldbus Terminals. 
Reconfigure unit and try again.

This error message appears when 
the HART app found voltage on the 
FF connector during initialization and 
during reconnection to a device.

CDC Error...“failure while switching to HART”...Reinstall 
System Files...See Users’s Manual for details

This error message appears when 
the HART app fails to put the CDC in 
HART mode for talking to a HART 
device.

DD Error…"tokenizer mismatch"…DD version 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>; HART application <version x.y>; HART app 
version x.y...Reinstall DD…See Programming Interface for 
details

This error message appears when 
the version of the tokenizer used to 
tokenize the DD is not what the 
HART app expects.

DD Error…"linker mismatch"...DD version x.y; HART app 
version x.y...Reinstall DD…See Programming Interface for 
details

This error message appears when 
the version of the linker used to link 
the DD is not what the HART app 
expects.

DD Error…"developed-to mismatch"…DD version 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>; HART application <version x.y> …See 
Programming Interface for solution. 

This error message appears when 
the DD was developed and tested 
using a later HART app revision.

Warning: this DD is untested with the current Hart App ver 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>…you may experience unexpected or 
inappropriate results…See Programming Interface for 
details on DD updates…Do you want to accept these risks 
and proceed?

This warning message appears when 
the DD was not tested and verified 
with the HART app.

DD Error…"tested-to sequence mismatch"…DD version 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>; HART application <version x.y>; HART app 
version x.y…See Programming Interface for solution

This error message appears when 
the DD was tested with a previous 
version but not with this version of the 
HART app
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DD Error…"developed-to mismatch"...DD version 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>; HART application <version x.y>; HART app 
version x.y...Reinstall DD…See Programming Interface for 
details

This error message appears when 
the DD was developed using a later 
HART app revision.

DD Error…"DD header file corrupted"...Reinstall Device 
version <manufacture name, device name, dev. rev. #, and 
DD rev. #>; HART application <version x.y> …See 
Programming Interface for details

This error message appears when 
there is a check sum error in the DD 
header file.

Hart Application Error…"data compression dll is 
missing"…Reinstall System Files...See User's Manual for 
details

This error message appears when 
the data compression component 
can not be located.

Hart Application Error…"data compression dll is 
corrupted"…Reinstall System Files...See User's Manual for 
details

This error message appears when a 
required functionality is missing from 
the data compression component.

Memory Error…"data compression memory allocation 
error"…Restart Unit...See User's Manual for further details

This error message appears when 
HART app is unable to acquire 
enough memory for data 
compression.

DD Error…"failure while opening DD"...Reinstall Device 
Type x Device Rev x dd Rev x…See Programming 
Interface for details

This error message appears when 
the system can not open the DD file.

DD Error…"failure while uncompressing DD"...Reinstall 
Device revision <manufacture name, device name, dev. 
rev. #, and DD rev. #> …See Programming Interface for 
details

This error message appears when an 
error is detected while 
uncompressing the DD.

Communication Error…"unexpected return value"…See 
User's Manual for solution

This error message appears when an 
unexpected value returned from a 
function call.

DD Error…"DD file corrupted"...Reinstall Device revision 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>…See Programming Interface for details

This error message appears when 
the checksum of the DD does not 
match with that described in the DD 
header file.

Forward Compatibility Blocked…DD Device Type x Device 
Rev x dd Rev x cannot be used in forward compatibility 
mode…x… Do you wish to proceed in forward compatibility 
mode?

This error message appears when 
the HART app attempts to use a DD 
to run in forward compatibility mode 
and finds that the DD is prevented 
from running in forward compatibility 
mode

DD Not Installed…DD device type x device rev x is not 
installed on the System Card…See Programming Interface 
for details on DD updates…Do you wish to proceed in 
forward compatibility mode?

This error message appears when 
the DD for the connected device is 
not in the unit.
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Fieldbus Error and Help Messages Description

DDP Error 1: Unable to load DD. Press OK to return to 
Block List

Using Easy Upgrade, check to see if 
this DD is available to load into your
375 unit. If not, contact the device 
manufacturer.

There has been a loss of communication with one or more 
devices on the segment. Press OK to return to the Live 
Device List.

Check connection to fieldbus 
devices.

“The 375 has been disconnected from the segment. Press 
RETRY to attempt to reconnect to the segment." Press 
CANCEL to return to the FF app main menu. Press EXIT to 
exit the FF App."

Verify that the 375 lead set is still 
securely connected to the FF 
Segment and press RETRY.

SM ERROR: FAILED RESPONDER IDENTIFY There is a problem sustaining 
communications with the device.
Contact 375 Field Communicator 
customer support personnel.

FFLIB: Incompatible DD Static Description The Device Description (DD) does 
not match the actual device correctly.
Use the 375 Easy Upgrade to see if a 
new DD is available for that device.
Contact 375 Field Communicator 
customer support personnel.

FBLIB: Device Upload aborted Communications with a device has 
timed out. This should normally not 
happen. Contact 375 Field 
Communicator customer support 
personnel.

FMS OTHER: Parameter Check The parameter being entered is 
invalid for this device. Check with the 
device supplier. Make sure the value 
entered is valid for that specific 
device parameter.

FMS OTHER: Exceeds Parameter Limits The parameter being entered is 
outside the range of valid values for 
the device parameter. Check with the 
device supplier. Make sure the value 
entered is in the correct range for that 
device parameter

FMS OTHER: Wrong Mode For Request The block is in the wrong mode to 
accept the parameter change being 
requested. See “Modes” on page 4-4 
for information on how to change 
block modes.

SM ERROR: REMOTE ERROR INVALID STATE An attempt to change the address of 
the device serving as the LAS on the 
segment is being made. Changing 
the device address of the LAS is not 
recommended.
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REQUIRED 
INFORMATION 
FOR 
TECHNICAL 
ASSISTANCE 

Before you call for technical support personnel, 
have a detailed description of the issue including 
the following (if applicable) information:
• Manufacturer and model of control system (if 

applicable)
• 375 Field Communicator system software 

revision
• Manufacturer ID number or name and model 

revision of field device (As displayed on the 375, 
exact spelling if possible.)

• Have the User’s Manual for the field device 
available.

• Does communication work when certain devices 
or processes are not running?

• What is the total cable length run from the 
termination panel to the field device?

• What is the message on the 375 Field 
Communicator when attempting to communicate 
with a field device (i.e., device not found)?

• What is the serial number of the 375 having the 
communication issue?

• Is the device in burst mode?
• What is the loop impedance in the device loop? 

(Resistance value)
• Can the 375 talk to the Field Device?
• Can the AMS Suite: Intelligent Device Manager 

talk to the Field Device?
• Is the Field Device address set to "0"?
• Is there more than (1) Field Device on the loop?
• Is there another master (primary or secondary) 

on the loop? (i.e., Control system, Multiplexer, 
etc.)
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• Does the Control system support HART or 
fieldbus communications?

• If a HART multiplexer is being used, what is the 
manufacture and model?

• What is the approximate Field Device loop 
length? (Length of the wire)

• Are there any error messages being displayed?
• What task is being performed when the 

communication problem occurs?
• Are you having communication problems with 

multiple Field Devices? 

Contacting Technical Support Personnel
Contact your supplier or go to the website, 
www.fieldcommunicator.com, for technical support 
contact information.
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USER’S MANUAL
00375-0047-0001, Rev. D
December 2004 375 FIELD COMMUNICATOR

APPENDIX A REFERENCE INFORMATION

PROCESSOR 
AND MEMORY 
SPECIFICATIONS

Microprocessor 80 MHz, max 133 MHz Hitachi® SH3

Memory Internal Flash 
32 MB

System Card
128 MB (or higher) Secure Digital card

RAM
32 MB

Expansion Module
32 MB (or higher) Secure Digital card

PHYSICAL 
SPECIFICATIONS

Weight Approximately 2 lb. (950 grams) includes battery

Display 1/4 VGA (240 by 320 pixels) monochrome touch 
screen with a viewing area of approximately 6 cm 
by 8 cm (10 cm diagonal)
Base glass thickness 1.1 mm anti-glare
Dimensions 92 mm x 71.1 mm x 10 mm
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Keypad Twenty-five keys including four action keys, twelve 
alphanumeric keys, four alternate functionality 
keys, on/off, and 4 navigation (arrow) keys; 
membrane design with tactile feedback

POWER 
SUPPLY 
SPECIFICATIONS

Power supply voltage
6.0 V

Battery
Five rechargeable NiMh AA batteries
Not serviceable.

Battery operating time
Eight hours typical use

Power Supply/Charger 
90-240 VAC, 50/60Hz,
US/UK/EU connection types included

CONNECTION 
SPECIFICATIONS

Battery Charger
2.5 mm jack

HART and Fieldbus Communication
Three 4mm banana plugs (one common terminal 
to both HART and FOUNDATION fieldbus.)

Personal Computer
IrDA port supporting up to 115 Kb/s
± 15 degrees recommended maximum angle from 
center line.
18 in. recommended maximum distance from 
center line.
IrDA requires Windows® 2000 or Windows XP
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ENVIRONMENTAL 
SPECIFICATIONS

Usage
-10°C to +50°C (14°F to 122°F)
0% to 95%RH (non-condensing) for 0°C to +50°C 
(32°F to 122°F)

Charge
0°C to +40°C (32°F to 104°F)

Storage
-20°C to +55°C (-4°F to 131°F) with batteries 
(less than one month)

Storage without batteries
-20°C to +60°C (-4°F to 140°F)

Enclosure rating
IP51 (front)

Shock
Passes the 1-meter drop test onto concrete
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ORDERING 
INFORMATION

Model Product Description
375 Field Communicator(1)

Code Communication Protocol
H HART
F HART and FOUNDATION fieldbus

Code Battery Type
R Rechargeable NiMH Battery Pack

Code Power Supply/Charger
1 Power Supply/Charger (90-240 VAC, 50/60Hz, US/UK/EU 

connection types included)
9 Not Included(2)

Code Language
E English

Code Product Certifications
KL CENELEC/ATEX, FM, CSA Intrinsically Safe

(includes FISCO as applicable)
NA No Approval

Code Easy Upgrade(3)

U Easy Upgrade Option (includes unlimited upgrades to System Card for 3 
year period)

9 Not Included
Code Options 

Spare Battery Pack
B Spare Rechargeable NiMH Battery Pack(4)

Expansion Module
C Configuration Expansion Module (5)

(1) Base Model 375 includes Field Communicator unit, System Card, Leadset with 
connectors, Carrying case, Getting Started Guide, User's Manual, 375 
Resource CD, stylus and straps.

(2) This option should only be considered if the user already has a 375 Power 
Supply/Charger. Note: Only 375 Power Supply/Chargers are to be used with 
the 375 battery pack.

(3) The Easy Upgrade capability allows the user to add new System Application 
software and Device Descriptions (DDs) to the 375. To upgrade without this 
feature, the System Card would have to be sent a Service Center. 

(4) A fully charged battery pack is capable of delivering power for eight hours of 
typical field use. If requirements exceed this specification, a second battery 
pack is recommended.

(5) The 375 is capable of storing a total of 25 configurations. For increased 
storage capacity, use the Configuration Expansion Module which is capable of 
storing in excess of 500 configurations.
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Spare Parts List

Description Part Number
Ruggedized 250 Ohm Load Resistor 00275-0096-0001
Rechargeable NiMH Battery Pack with Accessory Case 00375-0002-0011
Power Supply/Charger 
(90-240 VAC, 50/60Hz, US/UK/EU connection types included) 

00375-0003-0011

Lead Set with connectors 00375-0004-0001
Mounting Straps 00375-0005-0002
Carrying Case (with straps) 00375-0005-0003
Accessory Case (clips to Carrying Case) 00375-0005-0004
Stylus (pack of 5) 00375-0006-0001
IRDA to USB Adapter(1) 00375-0015-0002
Expansion Port Plug 00375-0035-0001
System Card - HART® and FOUNDATION fieldbus 00375-0042-0002
System Card - HART with Easy Upgrade Option(2) 00375-0042-0003
System Card - 
HART and FOUNDATION fieldbus with Easy Upgrade Option(2)

00375-0042-0004

Configuration Expansion Module 00375-0043-0001
Stand and Utility Plate 00375-0044-0001
Getting Started Guide 00375-0045-0001
User's Manual 00375-0047-0001
Resource CD(3) 00375-0049-0001
(1) For use with AMS/375 Interface or 375 Programming Utility.
(2) Includes unlimited upgrades to System Card for 3 year period.
(3) Contains Programming Utility and System Software/DD database. This CD is 

updated on a quarterly basis.
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December 2004 375 FIELD COMMUNICATOR

APPENDIX B APPROVAL INFORMATION

OVERVIEW This Appendix contains information on approved 
manufacturing locations, the European Directive, 
Hazardous Locations Certifications, and approval 
drawings for HART protocol.
All 375 Field Communicators come with the main 
unit label (see Figure B-1). Intrinsically Safe 
(KL option) 375 Field Communicators also have an 
additional label opposite the main unit label. If the 
375 Field Communicator does not contain this 
label (NA option) then it is considered non-IS 
approved. 

APPROVED 
MANUFACTURING 
LOCATIONS

Emerson Process Management — 
Leicester, England (UK)

EUROPEAN 
DIRECTIVE 
INFORMATION

CE Compliance
CE compliance to 89/336/EEC and 94/9/EC 
(KL option only)

Electro Magnetic Compatibility (89/336/EEC)
Tested to specifications EN 61000-6-3 and 
EN 61000-6-2

ATEX Directive (94/9/EC) (KL option only)
Emerson Process Management complies with the 
ATEX Directive. 
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Specific ATEX Directive Information is located 
within this section and in the 375 Field 
Communicator Getting Started guide. See “Label 
Drawings” on page B-4 for more information.
Applicable standards EN 50014, EN 50020, and 
EN 50284.

Other important guidelines
Only use new, original parts. 
Do not recharge the battery in hazardous areas.
Have repairs done only by qualified personnel.
Only charge or power using the 375 Power Supply.

HAZARDOUS 
LOCATIONS 
CERTIFICATIONS 
(KL OPTION 
ONLY)

North 
American 
Certifications

Factory Mutual (FM)
Intrinsically Safe for Class I, Division 1, Groups A, 
B, C, and D and Class I, Zone 0, AEx ia IIC T4 
(Ta = 50 °C) hazardous locations when connected 
as indicated in the control drawing 00375-1130. 
See the control drawing for input and output 
parameters.

Canadian Standards Association (CSA)
Intrinsically safe for use in Class 1, Zone 0, Ex ia 
IIC T4 hazardous locations when connected as 
indicated in the control drawing 00375-1130. See 
the control drawing for input and output 
parameters.
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European 
Certifications

ATEX Intrinsic Safety
Certification No.: BVS 03 ATEX E 347  II 2 G 
(1 GD) 
EEx ia IIC T4 (-10 °C ≤ Ta ≤ +50 °C)  1180

HART Intrinsically Safe electrical parameters

FOUNDATION fieldbus

Input Parameters
Ui = 30 Volt DC
Ii = 200 mA
Pi = 1.0 Watt
Li = 0
Ci = 0
Output Parameters
U0 = 1.9 Volt DC
I0 = 32 µA

Intrinsically safe FISCO
UiIIC = 17.5 Volt DC IiIIC = 215 mA PiIIC = 1.9 Watt
UiIIB = 17.5 Volt DC IiIIB = 380 mA PiIIB = 5.3 Watt
U0 = 1.9 Volt DC I0 = 32 µA

Intrinsically safe Non-FISCO
Ui = 30 Volt DC Ii = 380 mA Pi = 1.3 Watt
U0 = 1.9 Volt DC I0 = 32 µA
Li = 0 Ci = 0
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LABEL 
DRAWINGS

Figure B-1.  All 375 Field Communicators will have a similar label to the one below.

Figure B-2.  Approval Ex label example (KL option only)

Use only with 375 Battery Pack

Model 375
Serial No.   1 2 3 4 5 6 7 8

2004

20
03

 0
6 

50
 1Barcode

1180

375 Field Communicator
Emerson Process Management

Distribution Ltd
LE19 1WY      Leicester, UK

44.0mm

33
.0

 m
m

R = 1,5 mm
Label 1-1
ZN:2003 06 50 1

O O-10 C ≤ Ta ≤ 50 C

20
03

 0
6 

51
 1

Ba
rco

de

APPROVEDAPPROVED

CL I, ZONE 0, AEx ia IIC T4
CL I, DIV 1, GP A, B, C, D

Exia Ex ia IIC T4
CSA  2003 1433149

II 2 G (1 GD) EEx ia IIC T4
BVS 03 ATEX E 347

IS when installed per dwg 00375-1130
FISCO

IS for

T4 max amb 50�C

44.0mm

33
.0

 m
m

R = 1,5 mm

Label 1-2
ZN:2003 06 51 1
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Figure B-3.  Battery Pack Label example (all)

Use only with 375 Field Communicator

1180
Serial No.
2004 20

03
 0

6 
53

 1

375 Field Communicator   Battery Pack

Barcode

WARNING - BATTERIES MUST BE CHARGED
IN A NONHAZARDOUS LOCATION ONLY
WARNING - SUBSTITUTION OF COMPONENTS
MAY IMPAIR INTRINSIC SAFETY

                   1 2 3 4 5 6 7 8

M
ade in G

erm
any Emerson Process Management

Distribution Ltd
LE19 1WY      Leicester, UK

O O-10 C ≤ Ta ≤ 50 C

20
03

 0
6 

54
 1

CSA 2003 1433149   Ex ia IIC T4

BVS 03 ATEX E 347
II 2 G (1 GD) EEx ia IIC T4

APPRO VEDAPPRO VED

CL I, DIV 1, GP A, B, C, D
IS for CL I, ZONE 0, AEx ia IIC T4

T4 max amb 50�C

Label 4-1
ZN:2003 06 53 1

Label 4-2
ZN:2003 06 54 1

10
.0

 m
m

R = 1,5 mm

R = 1,5 mm

70.0mm
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APPROVAL 
DRAWING

This approval drawing can also be found on the 
www.fieldcommunicator.com website.
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GLOSSARY

Alphanumeric
A character set that contains both letters and digits and, usually, other 
characters, such as punctuation marks. 

AMS Suite: Intelligent Device Manager
Software for remotely managing Smart field devices (offline or online) 
over existing HART or FOUNDATION fieldbus networks. You can use 
AMS to monitor devices, configure devices, maintain calibration 
results, run diagnostic routines, and maintain historical data.

CDC
Communication and Diagnostic Circuitry

Data Link Time
Data Link Time is a network-wide time periodically distributed by the 
LAS to synchronize all device clocks on the bus. 

Device configuration
Parameters that define the physical attributes and operating 
characteristics of a device. Does not include dynamic data.
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Device Description (DD)
A set of instructions written in the HART or FOUNDATION fieldbus 
Device Description Language that defines the parameters and 
commands and methods that a host application uses to communicate 
with a HART or FOUNDATION fieldbus field device.

DDL
Device Description Language. A specialized programming language 
used to write Device Descriptions for HART or FOUNDATION fieldbus 
-compatible field devices. See also Device Description. 

Expansion Module (EM)
An optional removable memory card that snaps into the Expansion 
Port on the side of the 375 Field Communicator. See ordering 
information for availability types.

Field device
Field devices may generate or receive an analog signal in addition to 
the HART digital communication signal.

Fieldbus Foundation
The organization that develops and supports FOUNDATION fieldbus, 
an international, interoperable standard for communication of process 
automation and control information. Members include suppliers and 
end users of process control and manufacturing automation products. 
Support for the standard includes education, interoperability and 
conformance testing, testing tools, and development software.

FOUNDATION fieldbus 
A specific fieldbus technology developed and supported by Emerson 
Process Management and the other members of the independent 
Fieldbus Foundation. Foundation Fieldbus technology uses Device 
Descriptions and function blocks to enable intelligent field devices to 
execute control functions traditionally performed by a distributed 
control system. 
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HART device
A device that communicates information using the HART protocol.

HART loop
A communication network in which the master and slave device are 
HART-smart or HART-compatible.

HART protocol
Highway Addressable Remote Transducer communication protocol. 
An industry-standard protocol for digitally enhanced 4–20 mA 
communication with Smart field devices.

HART tag
An 8-character field used to identify a device. A 32-character long tag 
is also possible with HART Universal revision 6 device. This field is 
stored in the HART device and can be modified.

Instantiation
Some FOUNDATION fieldbus devices support instantiation of function 
blocks in the device. This means the device allows a command to be 
sent to it that will create or instantiate additional function blocks in the 
device. Once instantiated, these function blocks operate like any 
other block in the device. The 375 Field Communicator does not 
currently support the command to instantiate function blocks in a 
fieldbus device. The 375 Field Communicator is, however, able to 
access function blocks that have been instantiated by other external 
means.

Internal Flash
Non-volatile memory that stores the OS, application software, internal 
device configurations, event captures, fieldbus statistics, and user 
generated text files.
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Intrinsic Safety
Circuits that are designed to limit the amount of energy consumed or 
provided to field devices to levels below those that are required to 
ignite specific types of hazardous materials under fault and no fault 
conditions. 

Also a method of providing safe operation of electronic 
process-control instrumentation in hazardous areas, such as 
flammable environments. IS systems keep the available electrical 
energy in the system low enough that ignition of the hazardous 
atmosphere cannot occur.

Intrinsic Safety barrier
A physical entity that limits the current and voltage into a hazardous 
area in order to satisfy Intrinsic Safety requirements.

IrDA
Infrared Data Association, a non-profit trade association that 
establishes standards for infrared communications between devices 
such as personal computers, printers, and handheld devices.

Link Active Scheduler (LAS)
The bus arbiter for the segment. The LAS, recognizes and adds new 
devices to the link, removes non-responsive devices from the link, 
and distributes Data Link (DL) and Link Scheduling (LS) time on the 
link. 

Link master
A Link Master device controls when devices access the fieldbus and 
executes the link schedule which synchronizes communications with 
function block execution on the fieldbus. The H1 card or any field 
device that supports Link Master functionality can function as a Link 
Master device. Only one Link Master device can be active at a time 
on the fieldbus segment. This device is called the LAS.
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Link Scheduling time
Link Scheduling time is a link-specific time represented as an offset 
from Data Link Time. It is used to indicate when the LAS on each link 
begins and repeats its schedule. System management uses it to 
synchronize function block execution with the data transfers 
scheduled by the LAS. 

Personal Computer (PC)
Synonymous with microcomputer, a computer that serves one user in 
the office or the home. PCs are the largest installed base of personal 
computers. 

Polling
A method of sequentially interrogating a network to determine which 
devices are present.

Process variable (PV)
A process parameter that is being measured or controlled (e.g., level, 
flow, temperature, mass, or density).

Segment (Fieldbus only)
The section of a fieldbus that is terminated in its characteristic 
impedance. Segments are linked by repeaters to form a complete 
Fieldbus.

System Card
An internal Secure Digital Card with non-volatile Flash memory. A 
copy of installable 375 Field Communicator application software 
exists on every SC. The SC memory also stores all HART and 
FOUNDATION fieldbus Device Descriptions.

User data file
A text (.TXT) file created by a user either on a PC or with the 
ScratchPad application on the 375. User data files can be transferred 
between the 375 Programming Utility and a 375.
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INDEX

Symbols
.rec files 2-12
.txt file G-v
.txt files 2-17

Numerics
375 Main Menu 2-9

A
About 375 2-10
Address 4-16
Advanced features 4-18
Alphanumeric keypad 2-5, 2-7, A-2
AMS G-i
AMS Suite 2-15
Approval information B-1
Arrow, Back 2-9
ATEX B-1

B
Back arrow 2-9
Backlight 2-11

Key 2-5, 2-7
Basic

Features 2-5, 3-2
Functions 2-5, 3-2
Setup 3-17

Battery 2-22
Charger 2-13, 2-22, 2-23, A-2

Indicator button 2-2
Operating time A-2
Pack 2-2, 2-23
Specifications A-2

Bench 4-9
Bench wiring 4-9
Blocks 4-13

List 4-12

Brightness, see Backlight
 2-11

Button
FILTR 3-7
Home 3-15
Hot Key 3-3
Terminate 2-9
XPAND 3-8

C
Calibration 2-24, 3-16
Canadian Standards Association B-2
Certifications

European B-3
North American B-2

Changing modes 4-5
Charge A-3
Charger 2-5, 2-23, A-2
Cleanup 3-20
Clock 2-11
Communication 2-14

Terminals 2-5
Communication and Diagnostic Circuitry
2-10, G-i
Comparing

HART configurations offline 3-10
Components 2-5
Configuration 3-18

Comparing 3-10
Copying 3-9
Creating new 3-5
Deleting 3-9
HART offline 3-8
Offline configurations 3-5
Opening 3-7
Renaming 3-10
Sending 3-9
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Connecting
Load resistor 3-14
Power supply/charger 2-5
Specifications A-2

Contrast 2-11
Copying

HART configurations offline 3-9
Text 2-19

Cutting text 2-19

D
D/A trim 3-16
Damping 3-17
Date/Time 2-11
DDL G-ii
Deleting 2-20

Document 2-20
HART configurations offline 3-9

DeltaV System 4-18
Detail 4-15
Detailed Setup 3-17
Device

Blocks 4-13
Configuration 2-21, G-i
Description 2-16, G-ii, G-v
Descriptions 2-21, 3-20
ID 4-17
List 4-19
Revision 4-17
Setup 3-16
Status 4-15
Tag 4-16
Test 3-16, 4-3

Diagnostics
And Service 3-16
Fieldbus 4-19

Disconnecting
Fieldbus device 4-20
HART 3-22

Display A-1
Display, see Touch screen 2-5
Document 2-18

Deleting 2-20
Opening 2-20

E
Easy Upgrade 2-16

Edit
HART configurations offline 3-8

Electro Magnetic Compatibility B-2
Enclosure rating A-3
Enter key 2-5, 2-6
Entering text 2-18
Environmental specifications A-3
Equipment and componet directive B-1
Error messages 5-6
European

Certifications B-3
Directive information B-1

Event capture 2-12, G-iii
Exiting ScratchPad 2-20
Expansion Module 2-21, 3-20, A-1, G-ii
Expansion port 2-5

F
Factory Mutual B-2
Fast key 3-2
Features 2-5, 3-2

Advanced 4-18
Field device G-ii
Fieldbus

Bench wiring 4-9
Connecting the loop 4-7
Diagnostics 4-19
Field wiring 4-10
Foundation G-ii
Functionality 4-1
Online 4-7
Starting 4-6
Utility 4-18

Fieldbus loop
Terminals 4-8

File
Management 2-21
Transferring 2-16

Filter
Sort 3-7
Tag 3-7

FILTR button 3-7
Flash, see Internal Flash 2-21
Foundation fieldbus 2-13, G-ii

Application 2-10, 4-1
Function 3-2, 4-2

Blocks 4-13
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Key 2-5, 2-8
Functions 2-5

H
HART

Application 2-10, 3-14
Comparing offline 3-10
Copying offline 3-9
Deleting offline 3-9
Device G-iii
Disconnecting 3-22
Editing offline 3-8
Functionality 3-1
Icon 3-2
Load resistor 3-14
Loop 3-13, G-iii

Connecting 3-11
Terminals 3-12

New configuration 3-5
Offline 3-5
Open configurations 3-7
Polling 3-18
Protocol G-iii
Renaming offline 3-10
Sending configurations 3-9
Simulation 3-21
Starting application 3-2
Tag G-iii
Wiring 3-13

Hazardous Locations Certifications B-2
CENELEC B-3
CSA B-2
FM B-2

Home button 3-15
Hot Key 3-3

Cleanup 3-20

I
I/O block schedule 4-17
ID, Device 4-17
Ignored status 3-19
Installation

Battery Pack 2-2
System Card 2-2

Instantiation G-iii
Internal Flash 3-20, A-1, G-iii
Interoperability 4-3

Intrinsic Safety G-iv
Intrinsic Safey 2-24
Introduction 1-1
IrDA 2-5, 2-14, 2-15, G-iv

Adapter 2-14

K
Key

Alphanumeric keypad 2-5, 2-7, A-2
Backlight 2-5, 2-7
Enter 2-5, 2-6
Fast key sequences 3-2
Function 2-5, 2-8
Hot Key Options 3-3
Keyboard, see Soft Input Panel 2-9
Navigation 2-5, 2-6
On/off 2-5, 2-6
Tab 2-5, 2-6

Keypad, See also Alphanumeric keypad

L
LAS 4-2, 4-3, 4-11
LED 2-5, 2-8, 2-13
License 2-13
Link Active Scheduler 4-2
Link settings 4-19
Listen for PC 2-15
Live Device List 4-11
Load resistor 3-14
Loop

Connecting fieldbus 4-7
HART 3-13, G-iii
Terminals

Fieldbus 4-8
HART 3-12

Test 3-16
Troubleshooting 5-2

M
Maintenance 2-22
Managing files 2-21
Manufacturing locations B-1
Memory 2-13, 2-21, A-1

Specifications A-1
Messages

Error 5-6
Error and Status 5-6
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Safety 2-1, 3-1, 4-1
Status messages 5-6

Methods
Running 4-15

Microprocessor A-1
MODE_BLK.TARGET 4-5
MODE_BLOCK.ACTUAL 4-5
Modes 4-4

Auto 4-4
Changing 4-5
Listen for PC 2-15
Man 4-4
Other 4-4
Out of Service 4-4
Parameters 4-5
Permitted 4-5

Multifunction LED 2-5, 2-8, 2-13

N
Navigation keys 2-5, 2-6
New document 2-18
North American Certifications B-2

O
Offline

HART 3-5
On/off key 2-5, 2-6
Online 3-11

Fieldbus 4-7
Menu 3-14
Simulation 3-21

Opening
Document 2-18, 2-20
Saved configurations 3-7

Operating system 2-10
Ordering information A-4

P
Parameters

Changing and sending data 4-14
Displaying blocks 4-14
Functionality 4-14
MODE_BLK.TARGET 4-5
MODE_BLOCK_ACTUAL 4-5
Modes 4-5
Modified 4-14

Parts 2-5

Pasting text 2-19
Permitted Modes 4-5
Personal Computer A-2, G-v
Physical device tag 4-16
Physical specifications A-1
Polarity 4-7
Polling 3-18, 4-18, G-v
Power 2-13
Power supply/charger 2-5, 2-13, 2-23

Specifications A-2
Voltage A-2

Process variables 3-16, G-v
Processor specifications A-1
Programming Utility 2-12, 2-15, 2-16
Protocol

Fieldbus G-ii
HART G-iii

R
RAM 2-21, A-1
Range values 3-17
Reference A-1
Re-Flash 2-2, 2-10
Renaming

HART configurations offline 3-10
Repair 2-22
Replacement 2-22
Resistance

Troubleshooting 5-2
Re-test 4-20
Review 3-17
Revision

Device 4-17

S
Safety messages 2-1, 3-1, 4-1
Saving text 2-19, 2-20
Scaled D/A trim 3-16
Schedule

I/O Block 4-17
ScratchPad 2-17

Copying text 2-19
Cutting text 2-19
Entering text 2-18
Exiting 2-20
New 2-18
Opening 2-18, 2-20
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Pasting text 2-19
Saving text 2-19, 2-20
Selecting text 2-18
Undoing text 2-19

Screen
Backlight 2-11

Segment G-v
Selecting text 2-18
Self test 2-24
Sending

HART configurations 3-9
Sensor trim 3-16
Settings

About 375 2-10
Backlight 2-11
Clock 2-11
Contrast 2-11
Event capture 2-12
License 2-13
Link 4-19
Memory 2-13
Power management 2-13
Running 2-10
Touch screen 2-14

Shock A-3
Shutting down 2-3, 2-4
Simulation 3-21
Slot time 4-19
Soft Input Panel (SIP) 2-9
Sort 3-7
Specifications A-1

Alphanumeric keypad A-2
Battery A-2
Charge A-3
Charger A-2
Communication A-2
Connection A-2
Display A-1
Enclosure rating A-3
Environmental A-3
Expansion Module A-1
Internal Flash A-1
Memory A-1
Microprocessor A-1
Personal Computer A-2
Physical A-1

Power supply/charger A-2
Processor A-1
RAM A-1
Shock A-3
Storage A-3
System Card A-1
Usage A-3
Weight A-1

ST_REV 4-3
Starting up 2-3, 2-10
Status

Device 4-15
Messages 3-1, 5-6
Number of Ignored 3-19

Storage A-3
Cleanup 3-20
Device configurations 2-21
Files 2-21
Internal Flash 2-21
Types 2-21

Stylus 2-5, 2-9
System Card 2-21, 2-23, A-1, G-v

Installation 2-2
System software 2-10

T
Tab key 2-5, 2-6
Tag 3-17, 4-16

filter 3-7
HART G-iii
Polling 3-18, 3-19

Technical support 5-10
Terminals 2-5, 3-12, 4-8, A-2
Terminate button 2-9
Test

Device 3-16, 4-3
Loop 3-16
Self 2-24

Text
Copying 2-19
Cutting 2-19
Deleting a document 2-20
Entering 2-18
Opening 2-20
Paste 2-19
Saving 2-19, 2-20
Selecting 2-18
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Undoing 2-19
Time/Date 2-11
Touch screen

Alignment 2-14
Display 2-5
Using 2-8

Transferring files 2-16
Trim

D/A 3-16
Scaled D/A 3-16
Sensor 3-16

Troubleshooting 5-1

U
Undoing text 2-19
Usage A-3
USB 2-14
User data file G-v
Using this manual 1-1
Utility 4-18

Fieldbus 4-18

V
V(FUN) 4-18
V(NUN) 4-18
Voltage 3-1, 3-22, 4-6, A-2

Troubleshooting 5-3

W
Waste 2-24
Web site 4-3, 5-11
Weight A-1
Wireless communication 2-14
Wiring

Fieldbus 4-9, 4-10
HART 3-13
Troubleshooting 5-4

X
XPAND button 3-8
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